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Staying organised is a massive part
of my working life, so having iOS’s
Collections, Moments and Years
feature applied to Photos is
perfect for me.

Oliver Hill

The speed difference in Photos is
instantly noticeable. You can tell
this is an app that has been built
from the ground up with the
modern photographer in mind.

Philip Morris

I was worried by the lack of pro-
level editing tools, but having
played around with Photos, I can’t
see a great deal I’m going to miss
about Aperture.

Will Shum
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O ne of the unique selling points of a Mac 
is its premium build quality. When you
buy one, you know you’re getting a

cutting-edge machine built to last. But given the
demands we put on our Macs, none are truly
invincible. So this month we set out to find 50
ways to set up the perfect Mac – giving it the best
possible opportunity to last longer than ever. In
the feature that starts on page 18, we’ll show you
how to run at optimum speed, diagnose and fix
problems, clean your hard drive and upgrade your
hardware. In eight packed pages we’ll effectively
future-proof your Mac for you. Essential stuff!

Our other feature, Best Extensions for OS X and
iOS, will supercharge how you use your first-party
apps. Where both operating systems were
previously out of bounds to third-party
developers, both OS X and iOS are now awash
with some brilliant extension tools. We’ve rounded
up the best for you over on page 58.

Meanwhile, the wait for us to get our hands on
Photos finally ended. You need a developer
account to use the beta, but we’ve put together a
hands-on preview to take you through the new
features. It’s a big improvement on iPhoto, as you’ll
find out on page eight.

Of course, it wouldn’t be iCreate without stacks
of creative and technical tutorials for Mac and iOS,
and this month is no different. We’re solving all
your problems in our Genius Bar feature on page
74 and reviewing all the best hardware and
software too. Don’t forget FileSilo either, our home
for all our free digital downloads. Enjoy the issue.

The beta version of Photos has landed. 
Here’s what the iCreate team like most

Are you excited about Photos, Apple’s new image-editing app? Join the
conversation over on our Facebook page and @iCreateMagazine

Meet the team
Storing full-res images in my new 
iCloud Photo Library is going to 
save a huge amount of space. 
Anything that eases the load on 
my hard drive is good by me!

Dan Hutchinson

“In eight packed pages 
we’ll effectively future-
proof your Mac for you. 
Essential stuff!”

Deputy Editor
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Supercharge the way you use
your devices with third-party apps
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Join our

Hi. We love making iCreate and hope you

enjoy reading it every month. This ye

want to go a step further by invi

take part in a quick reader survey.

even be selected to join our first ev

panel, where you’ll be able to help s

the future of your favourite magaz

We’re looking forward to hearing

what you’ve got to say…

READER SURVEY

Philip Morris
Deputy Editor

Reader Panel
today!

Join our panel and help
us make the magazine
even better!
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Take our 3-minute survey at 
www.icreatemagazine.com/survey 
and win a place on our panel 



  See new ideas and changes before anyone else
Get invited to attend special events in your area

 Test third-party products for review
 Have a chance to meet the iCreate team 

Shape the future issues of the magazine
 Enter into exclusive competitions

Complete our survey to join our 
iCreate panel and:

Complete our survey and win your place today
www.icreatemagazine.com/survey

Take the 
survey on 
any device

Only 
takes 3 
mins!

Complete
 survey

Step 1
Get 

involved

Step 2
Earn 

rewards

Step 3

Take the chance to get 
closer to the team than 

ever before
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Photos is finally here. Well, at least in 
developer land it is. There may be a 
public beta version soon, but in all 

probability, the average Mac user won’t be 
able to get their hands on Apple’s brand new 
image-editing app until April. Thankfully 
iCreate has got hands-on with Photos in 
the hope of answering some of your most 
burning questions. Updates to Apple’s iLife 
suite don’t come round very often; the holy 
trinity of iPhoto, iMovie and GarageBand 
is being outgunned and that’s very big 
news for any Mac user. Photos is a vast 
improvement on iPhoto, Apple’s trusty but 
tired photo organising and editing software. 
It hasn’t had a major update since 2010, and 
we’ve been crying out for something new. 
Well, Photos is here. And it’s looking very 
good. Here’s what we found when we spent 
some quality time in its company.

The switch from iPhoto
If you’ve spent years building your iPhoto 
library, you’d be forgiven for holding a few 

misgivings towards Photos. Wondering ‘will 
my library transfer across’ probably being 
the main one. It could be that Apple spent 
the time since it announced Photos (way 
back at WWDC in June 2014) with its ear 
firmly to the ground, listening to iPhoto 
users’ thoughts, because the switch is going 
to be seamless. When you first open Photos 
you’ll be presented with a welcome that tells 
you exactly how to import to Photos. While 
it doesn’t happen automatically, it’s only a 
simple case of dragging and dropping files 
into the Photos window. So to move your 
complete iPhoto library, head to your Mac’s 
Pictures folder, find your iPhoto Library file 
and then drag it to Photos. This is going 
to take some time, if like ours, your library 
extends over 10GB. 

You’ll see your photos appearing in the 
main viewer (there’s a loading circle at the 
top to give you an idea of time left, and a 
notification appears in the top-right corner 
when it’s complete) and you can still use 
Photos while the import materialises. iPhoto 

Apple’s new image-editing app is finally in developer beta. We 
went hands-on with Photos to discover if it was worth the wait

“Photos is a vast improvement on iPhoto, 
Apple’s trusty but tired photo organising and 

editing software”

Key features
Brand-new app, built 

from the ground up
Modern interface

Powerful editing tools
iCloud Photo Library

Creative projects 
Sharing options aplenty

#Trending
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Editing images in Photos
Hands-on with Photos’ iOS-inspired layout

  Reset
All editing in Photos is non-destructive, 
meaning you can reset adjustments as 
and when you please. Your iPhoto edits 
will transfer across, and clicking Revert 
to Original will do as it says. Photos 
takes the hassle out of photo editing 
and encourages you to get creative.

  Zoom
Photos enables you to get up close and 
personal with all your editing. You can 
use the slider in the top-left of the main 
toolbar to zoom in and out, or use a 
Magic Mouse or trackpad to perform a 
thumb and finger pinch gesture. Great 
when using the Retouch tool.

  Detail sliders
Anyone who has worked with Photos 
on iOS will appreciate how editing on 
your Mac is now done. These super-
intuitive sliders let you scrub up and 
down the timeline looking for the perfect 
composition, while enabling complex 
adjustments via more drop-down sliders.

  Add commands
You can customise how your 
Adjustment menu looks depending on 
your favourite edits or the picture in 
question. If you hit the Add button, you 
get a long list of other features, such as 
the histogram and white balance. Just 
click on one to add it.

  Tools
Photos’ real editing power lies in its 
Adjustments menu, but you’d be 
foolish to ignore the other options. All 
your bases are covered, from one-click 
enhancements and filters to essential 
cropping and rotating tools. Photos 
leaves no stone unturned.

  Full preview
As you’re using the sliders to make 
adjustments, you’ll see a full live 
preview to your image. This way you 
get a clear picture of how your editing 
is coming along, making sense of 
the tiny numbers found under the 
individual editing sliders.



10

will remain on your Mac, but don’t expect any official 
updates to materialise. Any Keyword, Description 
and Faces metadata will transfer across, but iPhoto’s 
Rating system has been replaced by a Favorites option, 
symbolised by a heart. Edits you’ve made in iPhoto will 
remain and you can tweak them in Photos.

Interface and performance
Anyone who has used Photos on iOS since its 
introduction to iOS 8 has a huge head start when it 
comes to using Photos on Mac. All your pictures are 
organised into Moments, Collections and Years, just like 
the mobile version. We love how easy it is to quickly 
flick through thousands of thumbnails and instantly 
view larger previews if you want. Apple believes you’ll 
see more of your pictures in every view, by up to 67 per 
cent. And we’re not arguing with that statement. 

Your photos take pride of place here – navigational 
tabs, buttons and the main toolbar have been 
significantly redesigned to make sure you’re seconds 
away from doing what you want. The Albums view in 
particular impressed us. Effectively replacing iPhoto’s 
torturous Events tab, Albums is the place to come for all 
your panoramas, time-lapse and burst photography, but 
also your normal and slo-mo videos (you can even do 
some basic video editing in Photos). Again, anyone with 
an iPhone or iPad will be more than familiar with this 
particular line-up. 

Photos is refreshingly quick, too. iPhoto had become 
tied down by its library size, leaving the app slow and 

lethargic. Even in developer beta, Photos is lightning 
quick – a really modern-feeling piece of software in 
more ways than one.

Editing your images
Photos has a lot more to offer thanks to some seriously 
powerful editing tools. Double-click any photo to bring 
it full screen and hit Edit in the far-right of the main 
toolbar. This brings up a sidebar of six editing tools 
at your disposal. Enhance (a one-click fix for boosting 
colour and saturation), Rotate and Crop are all basic but 
essential tools. The Filters menu gives you eight types 
of filter to add to your images; all can be found in the 
mobile version of Photos, but don’t let that put you off, 
because there’s plenty of choice. 

Photos comes into its own when you get to the 
Adjust option. Your default Adjustments panel is made 
up of Light, Color and Black & White, but this can be 
adjusted to personal use by hitting the blue Add button 
at the top. This opens up a treasure chest of additional 
options: Histogram from the Basic options, Sharpen, 
Definition, Noise Reduction and Vignette from the 
Details options and White Balance and Levels from the 
Advanced section. The Retouch brush showed itself to 
be a fantastic tool at removing blemishes.

Edits are easily performed, thanks to the 
implementation of smart sliders, which give you live 
previews of edits as you scrub up and down the 
timeline searching for the perfect balance. While these 
edits don’t reach the same levels of performance as 

#Trending

What’s 
happened to 
Aperture?
When Apple announced Photos 
as a replacement for iPhoto and 
Aperture, one of the biggest 
queries we had was how 
Aperture’s professional-grade 
features were going to make 
the transfer. Aperture itself 
will still run on your Mac, but it 
isn’t going to be supported by 
Apple going forwards. Photos 
will do an admirable job at 
editing any dodgy image, but 
in truth, it was fanciful thinking 
that Apple was going to copy 
£59.99/$79.99 worth of software 
into Photos and Aperture 
users are going to find Photos 
wanting in some areas. Photos 
is no direct replacement – 
professional users will want to 
check out some alternatives.

The way your photos are organised 
will be familiar to any iOS user
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Aperture, they are very powerful and not to be mocked. 
Photos is going satisfy the vast majority of mainstream 
photographers, and that’s no mean feat for a free app.

iCloud Photo Library
Photos continues Apple’s drive to store everything in 
the cloud. iCloud Photo Library means every photo 
or video you take now lives in iCloud, enabling you to 
access your entire library from any device, at any time. 
Take a photo on your iPhone and it’ll be automatically 
pushed to your Mac and iPad. Make an edit on one 
device and the same happens. You can even access 
your library from any browser from icloud.com. 

You will have to pay for the privilege, though. Cloud 
storage doesn’t come free, well 5GB does, but after that 
you’re going to have to pay a monthly fee, although 
£0.79/$0.99 a month for 20GB is a small price to pay. 
If you click Optimize Mac Storage you can keep full-

resolution copies of images and video in iCloud and 
keep just storage-saving thumbnails on your machine. 
You’ll be easing the load on your Mac’s hard drive, but 
paying for extra cloud storage.

The future
All the sharing options you expect are present and 
more can be added via OS X’s new Extensions menu in 
System Preferences. Those who loved iPhoto’s creative 
Card, Photo Book and Calendar projects will also be 
pleased to know they have survived the migration, 
while setting up a slideshow is as easy as ever. 

We’re delighted to say that Photos is a massive 
improvement on iPhoto. Photos represents everything 
a photo-editing app should be in 2015 and much more. 
We can’t wait for the full version to launch, and rest 
assured, we’ll be the first to give you detailed tutorials 
on everything worth knowing.

Three key 
features

Image metadata
With any image selected, hit the 
Info tab to be presented with 
a host of information about 
your image. This menu also 
gives you shortcuts to adding 
organisation details, such as a 
description, keyword and face.

Retouch tool
The power of Photos’ editing 
features shouldn’t be frowned 
upon. The Retouch tool, for 
example, enables you to get 
rid of unwanted subjects, 
seamlessly blending these stray 
pixels into the background.

Projects
iPhoto’s creative projects have 
survived. Photos is now the 
place to come to if you want 
to make special gifts from your 
favourite images. Photos will do 
all the hard work for you and let 
you order a hard copy, too.

Photos has eight built-in
filters available to use



Apple Watch
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“The Apple 
Watch looks 
vastly more 
customisable than
the present Android
Wear options”

I t’s been a long time coming, but the release
of Apple Watch is around the corner and we
for one can’t wait. Details of what to expect

from Apple’s first foray into the wearables
market have gradually been unveiled and
we’ve now got a semi-complete picture of
what to expect. While Apple has been busily
getting things ready for launch, Android
Wear will soon be celebrating its first birthday.
Android’s own smartwatch ecosystem has
already seen over 20 different smartwatches
from the likes of Motorola, LG, Sony and
Samsung and the swathe of watches doesn’t
seem to be slowing down anytime soon. But
the question remains, how will Apple Watch
compete with Android Wear? We’ve delved
deep into the world of wearables to find out.

Design and comfort
Both Apple Watch and Wear smartwatches
utilise a multi-strap system that enable users
to choose the exact type of band they want
to use, including a wide range of third-party
offerings. Apple Watch alone has a set of
rubber and metal bracelets available, purely
depending on the look you’re going for and
the budget at your disposal. Although Apple
has gone straight for a premium finish with its
watch faces, especially the 18-Carat Rose Gold
variant, it’s taken Android Wear manufacturers
a long time to get the recipe right. They’ve

seen numerous plastic offerings that have
simply missed the mark for most of the

audience. All of this trial and error by
Android manufacturers means that

Apple will be able to learn from
the mistakes made by the

competition and deliver
a product that both

looks great and
feels nice and

secure on
the wrist.

Fitness first
One of the areas in which Apple is marketing 
its smartwatch is through the health and 
fitness benefits. The included Activity app 
monitors how often you’re moving, exercising 
and standing still, to give you an in-depth 
look at how your fitness is on a daily basis 
with the help of various charts and graphs. 
Although not directly linked, the Apple Watch 
also includes Wi-Fi and GPS capabilities, an 
accelerometer and heart rate sensor that 
should help third-party developers bring 
their own fitness apps to the device. The 
story is very different for Android users. 
Although nearly all Wear smartwatches have 
some degree of fitness integration, there are 
numerous Android-enabled fitness bands to 
compete against that offer a more complete 
fitness tracking system.

App selection
Both Apple and Google have released 
speciality development kits for their 
smartwatches, giving developers the chance 
to really take smartwatches to the next level by 
porting their apps to your wrist. After almost 
a year of available apps, there are around 100 
compatible Wear apps, varying in quality of 
course. Apple’s more stringent policy 
of scrutinising apps will be 

How will Apple’s first wearable stack up against the Android offerings?

Stay in touch no matter where
or how you’re travelling
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coming into play with any app developed 
via WatchKit. Although the number of Apple 
Watch apps available through the App Store 
will appear at a generally slower rate than the 
Google Play counterparts, you can usually 
guarantee they’ll be of a premium quality. 
Some of the companies already on-board with 
WatchKit include Uber, Foursquare, Todoist, 
with many more working behind the scenes.

The price is right
One of the biggest advantages that Android 
Wear has over Apple is the pricing. With 
most new Wear smartwatches now retailing 
around the £189 mark, and secondhand units 

selling closer to £139, Apple’s much 
higher price point will certainly be a big 
factor for the more casual consumer. 

However, as with every Apple product, 

there’s a dedicated userbase who 
will undoubtedly pay extra to have the 
premium finish that Apple can offer. We’ll
even go as far as to say that the exclusive gold
variant that Apple is looking to launch (the one
that’s rumoured to be selling at over £1,000), 
will soon be snapped up by eager customers. 
It will certainly be interesting to see what 
price Apple finally settles on for its UK and 
international release.

Ease of use
If you’re planning on investing in a smartwatch,
one of the main reasons you’ll do so is to 
take away how much time you spend on 
your phone. Thanks to the dedicated watch 
interfaces, both Apple and Google have 
produced a surprisingly thorough but simple 
system to help make managing certain aspects

Apple Watch
competitors
With Apple’s launch 
imminent, how will it 
stack up to some of 
Android’s best offerings?

Sony Smartwatch 3
Sony’s third smartwatch 
shows that it’s learnt 
from the mistakes of the 
previous offerings. The 
Smartwatch 3 is a super-
slim smartwatch that 
offers one of the best 
integrations of Android 
Wear on the market. 
What makes it an even 

better prospect for new 
users is that it’s somewhat 

cheaper than most of the 
competition on the market.

Motorola 360
The Motorola 360 is arguably 

the closest resemblance 
to an actual wristwatch 

you’ll find on the 
market. Its minimal 
design certainly gives 
off a nice aesthetic, 

especially when 
wearing the full metal 

version. The circular 
screen isn’t the best for 

swiping through notifications 
and menus, but the added 
processing power is a great help.

of a phone easier. Apple users in particular 
will be able to manage various notifications, 
from emails and SMS messages, as well as 
their music stream. What we also like about 
the Apple Watch is the ability for the user to 
fully customise the honeycomb style layout to 
prioritise the apps that they want easy access 
to on their wrist. In essence, the Apple Watch 
looks vastly more customisable than the 
present Android Wear options.

Customise Apple Watch’s app 
screen with ease

Sync your smartwatch with your
phone in just a few seconds

Apple Watch has an array of fitness tools



A common mistake that many users make when shooting images is leaving too
much blank space around the edges. Although many will try to experiment with 
cropping their images, the new Photos app has a built-in Auto Crop function 
that does the job for you. Load up any image within Photos and press on the 

Edit button that can be found at the top-right of the menu. An array of different editing tools 
will now appear, including the Crop tool. Open this menu, but before making your own edits, 
instead use the Auto option that sits at the bottom. The app will now automatically detects 
the areas that can be cut and make the edits needed. By using the option several times on 
the same image, you can make small and subtle cuts to it, which should help avoid any 
substantial cropping issues that could appear if you were to do it manually.
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There’s lots to like about Photos
Photos
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You don’t have to put up with 
incorrect album artwork iTunes

After using the automated system 
to add album artwork in iTunes, on 
occasion you may find that the 
wrong artwork has been applied. 

It’s a fairly uncommon error, but it does happen. 
To remove misplaced artwork, right-click on the 
album in question and select the Clear 
Downloaded Artwork option. This shortcut also 
works well when highlighting multiple albums 
that you want to clear at the same time. Once 
this is complete, you can go through the 
process of adding the correct artwork manually. 
To do so, right-click any album cover and select 
Get Album Artwork.

Hunting for Notification Center 
widgets is easy App Store

Exploring different ways to 
customise your Notification Center 
menu is one of the most exciting 
things about Yosemite, but the 

choice of apps that it links with aren’t easy to 
discover. Instead of trawling through the Mac 
App Store on the off chance you’ll find a 
compatible app, open up the Notification 
Center menu and select the Edit button at the 
bottom. The menu will now expand and a new 
App Store option will appear at the bottom. 
Select it and you’ll be taken to the dedicated 
App Store page that lists a selection of the very 
best compatible apps.

You can make Safari more 
personable Safari

After using Safari for a significant 
period of time, you’ll find that the 
Top Sites list you see from the top 
address bar will consistently grow. 

However, by default you’ll find that only a small 
number of sites will be listed in this menu, 
when there’s enough room for many, many 
more. Select the Safari option from the toolbar 
and then the Preferences option that’s 
provided. From here you’ll want to open the 
General tab and select the Top Sites menu. Now 
you can customise how many sites will be 
shown in this menu. No more tediously typing 
out long URL addresses.

Photos on iOS is an 
underrated image editor Photos

Let’s face it, some of us aren’t 
confident when it comes to photo 
editing on our iPhones, but there’s 
a simple solution to be found 

within the Photos app that many of us are 
probably loading up a third-party app to do. If 
you select the Edit option while viewing an 
image, you can pick one of the editing dials at 
the bottom of the screen. Each of these dials 
contains a slider in the form of a timeline, which 
can be adjusted to alter various aspects of the 
image. For example, one of the sliders adjusts 
how bright an image is, without needing to 
master any advanced options. 
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Do you really know
how much space
your tracks in Music

take up on your iPhone? If
not, you can take a closer
look by opening up the
Settings app. Use this tip to
have a spring clean and free
up some valuable space.

1 Manage Music
in Settings

1 Open Usage menu
Open the Settings app and select
General from the menu. Now scroll
down and open the Usage menu
that’s provided on the next list.

2 Select Music option
Select the Manage Storage option
and find the Music app from the
list that follows. A list of all your
downloaded music will now show.

3 Delete if necessary
Each listing will show how much
space they take up. Swipe left to
open the Delete screen where you
can choose which songs to remove.

If you’re juggling
with multiple email
drafts all at the

same time, use this quick tip
to organise them into tabs,
just like you do with Safari’s
feature. It really is a great way
of keeping your messages
nice and organised.

2 Use Safari-like
tabs in Mail

1 Create an email
Create a new email in Mail, but
swipe downwards from the top of
the message instead of sending it
straight to a contact.

2 Add a new draft
Create two other emails, or open
up two from your inbox. The title of
a recent email will now be listed at
the bottom for you to access.

3 Use your tabs
Press on the recent email at the
bottom to open the tab menu.
Swipe left to delete, or press on one
to open it and take a closer look.

Your System
Preferences app
is your hub for all

things technical, but by
default it can be fairly
cluttered. Use this guide to
quickly streamline how it
looks on your Mac and find
what you want in an instant.

3 Customise
System Preferences

1 Customise menu
Open the System Preferences app
and once the menu has loaded,
select the Customise option from
within the View tab on the toolbar.

2 What to select?
Each icon in the menu will have
a box next to it where you can
choose to remove it from your
menu. Go ahead and select a few.

3 Confirm it
Press the Done button once you’ve 
finished choosing. The menu will 
reformat itself and you’ll have a 
much cleaner menu.

One of the best things about Apple devices is that they’re full of
little hidden features, which is the focus of this issue’s five-minute
projects. The first project will show you how to manage your music
more effectively and save space where needed. If you’re an avid Mail
user, then our second tip on getting Safari-like tabs will be ideal for you.
Finally, we’ve got a clever trick to streamline your System Preferences
menu without any third-party apps.

minute projects
to try today

3
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DaVinci Resolve 11 now adds professional nonlinear editing
to the world’s most powerful color grading system!

Native Camera RAW
DaVinci Resolve works natively with all major RAW formats!

Featuring the industry’s most advanced de-bayer algorithms, 

Resolve preserves every detail captured by the camera’s sensor. That means 

you can adjust exposure, shadows, highlights and mid-tones long after the 

camera stops rolling! With Resolve, you can create looks that simply aren’t 

possible on other systems. The native RAW workflow means your final

masters are literally first generation renders from camera original files!

Scalable Power
Hollywood’s leading studios choose DaVinci Resolve

because it handles incredibly high resolution images

and massive amounts of data easily on super tight deadlines. Resolve 

is scalable and works on laptop’s up to massive multi GPU systems

connected to shared storage. Whether you’re working on HD, 4K or

beyond, DaVinci Resolve has the power, performance and creative

tools you need to get the job done!

Integrated Editing and Grading
DaVinci Resolve 11 gives you professional editing

and color correction all in one system so you can

move between editing and grading with a click of the mouse!

No more importing, exporting, or conforming ever again! Teams

can have multiple colorists and assistants working with an editor

on the same sequence at the same time! You get a true nonlinear

workflow that lets you edit, grade and finish faster than ever before!

Professional Nonlinear Editing
DaVinci Resolve’s multi-track timeline lets you quickly

ripple, roll, slip, slide, extend and shorten edits. The

context sensitive trim tool changes automatically based on the position

of the mouse to make editing faster! Dynamic JKL trimming works on

multiple tracks and can be done in the same direction or asymmetrically.

Whether you use the mouse or keyboard, Resolve is easy to learn and

has all of the tools professional editors need!

www.blackmagicdesign.com/uk

DAVINCI RESOLVE 11 LITE
Free download with unlimited nodes. 

Supports 1 GPU.

Free Download

DAVINCI RESOLVE 11 SOFTWARE
Full Resolve with unlimited nodes and multiple GPUs.

Use 3rd party control panels.

£665*

DAVINCI RESOLVE 11
Full Resolve with colorist control surface 

for the most advanced facilities.

£19,975*

DaVinci Resolve 11 combines the world’s most advanced color corrector with professional multi-track editing so now 

you can edit, color correct, fi nish and deliver all from one system! With its legendary image quality, real-time GPU 

accelerated performance, and support for more wide dynamic range RAW formats than any other system, DaVinci Resolve 

has the creative tools professional editors and colorists need to work on Hollywood’s most demanding projects!

*SRP is Exclusive of VAT
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If you would like more help with upgrading your Mac, visit the gadget
surgeons at iFixit.com, who kindly contributed these photos. 25







28

There are three great facts about iPhoto’s Effects palette that no one 
who has used it can deny. The first is that anybody, yes anybody, can use 
it – whether you are a complete beginner or a seasoned enthusiast. With 
just a small dash of know-how you can quickly combine filters to create 
jaw-dropping results. The second is that using the Effects range is actually 
really good fun. Like a kid with a new paint box, iPhoto’s Effects palette is 
the perfect place for experimenting; thanks to the real-time preview you 
can instantly assess changes and either develop the image further or go 
back a step or two with a simple click. The third and unquestionable truth 
is simply that the set of filters will dramatically enhance any image you 
send its way. Here’s how it works.

How and when to apply filter effects
iPhoto’s pleasing palette of filters offers photographers a one-stop-shop for transformation 

Difficulty
Beginner

Time needed
30 minutes

Step-by-step Using Effects to add filters 

iPhoto

1 Antique
The Antique filter is a great choice for landscape 
and architectural photographs, where a level of 
tone and depth is needed. Don’t go too far with
this as details will darken and muddy. 

2 Sepia
Sepia is perfect for aging photographs. This 
works well for landscapes, architecture, travel 
and portraits. The filter can flatten the range 
between highlights and shadows, though.

3 B & W
Using the B & W filter is the best way of getting 
rid of colour in iPhoto. Use this filter for shots 
that lack dynamism, or when you want to create 
a sense of drama or mood. 

4 Edge Blur
Edge Blur is ideal for when you wished you’d 
used a wider aperture to capture a softer 
backdrop. Use this to force interest onto your 
focal point, such as in macro shots.

5 Vignette
iPhoto’s Vignette can be a little heavy-handed 
but it’s useful for removing distracting elements 
from the corners without having to crop, driving
the viewer’s interest to the centre of the frame. 

6 Matte
Like Vignette, Matte isn’t likely to be a regularly 
called upon filter, yet it does offer a whimsical 
charm that can be used to add a sense of 
narrative and expression to a frame. 



Filter fun
Explore the Effects suite to transform your frames

 Bottom row
On the final row of options you’ll 
find two presets that enable you 
to affect the strength of colour, 
colour temperature and tone. 
Fade dilutes and cools, whereas 
Boost saturates and warms. Use 
these to counter dull and cold, or 
bright and brash imagery. 

Knowledge base
Compare and 
contrast
It can be hard to tell 
whether you are making 
improvements when 
editing. So create a 
duplicate and bring this 
into the Edit suite for an 
instant way of comparing. 
With the original open, 
press Command and D, 
then hold Shift and click 
the duplicate in the photo 
bar to bring it up next to 
the original. 

7 Boost
The Boost button is ideal for injecting some va-va-
voom. Not only does it saturate the colours but it 
adds contrast and warmth. Use this for lacklustre 
shots, such as those taken on dull days or in bad light. 

8 F
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u
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Top drawer
The top row of fa ilters are
used to add a col tment to your

e.
ns
.

 Border control
The second row of options allows
photographers to drive attention
onto the focal point of their image
by diluting interest in the outside
of the frame. It’s best to use these
effects in small doses.

I spy with my

little eye domains
ending in...

www.blacknight.host
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In these digital days there are many ways to capture action on a 
camera. With an iPhone always to hand you can capture spontaneous 
events as video clips. Small sporty cameras such as the GoPro Silver Pro 4 
enable you to film point of view (POV) shots of activities in high definition 
(without running the risk of cracking the screen of your less robust iPhone). 
When filming repetitive action (such as a friend whizzing past on a zip-
wire) you can capture the action from different angles. You can then cut 
the best bits from each repeated shot into a smooth-flowing sequence 
that looks like it was captured ‘live’ from a range of camera angles. These 
changing shot sizes and angles make your faux ‘multi-cam’ sequence look 
more professional and dynamic.

Fake a multi-camera shoot in iMovie
Edit clips together to look like you’re covering action from multiple camera angles

Difficulty 
Expert

Time needed
20 minutes

iMovie

Mimic multi-cam 
Cut between different camera angles 

  Layers
As the zip-wire action is 
the same in each clip, we 
can run the clips together 
as parallel layers in the 
Timeline. The content of 
the top layer is always 
visible in the main window. 

  Multiple angles
Here we have three clips 
of the same action (a girl 
whizzing down a zip-wire). 
We got the girl to repeat 
the action and filmed it 
from different angles. The
orange bars below each
clip indicate which sections
were used in the final edit.

  Split clip 
By splitting a clip on the top layer 
and then trimming its start point, it is 
possible to reveal some of the parallel 
action from the layer below from 
different camera angles.

  Music
A dynamic music track from the Sound Effects library’s 
Jingles folder helps knit our three separate video clips 
into a smooth-flowing multi-cam narrative. This helps 
it run in ‘real time’.

Knowledge base
Make your mark
When the girl reaches the 
end of the zip-wire there’s a 
clunk that’s audible in every 
camera angle clip. You can 
see this clunk as a peak in 
each clip’s audio channel, 
which helps you place the 
POV clip in sync with the 
action in the other clips. Tap 
the M key to place a blue 
marker when you hear the 
clunk. This marker offers an 
alternative way to help you 
sync your clips’ action.

FileSilo
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Step-by-step Fake a multi-camera shoot

1 Create an event 
Go to File>New Event. Label the event ‘Multicam
Event’. Go to File>New Movie. In the Create 
window choose No Theme. Click Create. Name 
the movie ‘Multicam Movie’. Click OK.

2 Import the clips
A new Project icon will appear, as well as an 
empty Timeline. Click the Import Media button 
and browse to select our folder of source clips. 
Click Import Selected.

3 Preview the clips
In the Event window, scrub the cursor along 
each clip to view a preview of its content. 
This helps you get to know the action in each 
camera angle and spot any continuity problems.

4 Select and add
Click on the Front Angle clip. Click and scrub 
to select it from just as the girl starts to slide 
forward until the end of the action. Drag this 
yellow selection into the Timeline. 

5 Add second angle
Click and scrub to select the Side Angle clip 
from where the girl starts to slide until the clip’s 
end. Drag the yellow selection and place it 
above the Side Angle clip in the Timeline.

6 Split the top clip
You now have two parallel clips running on 
separate layers. Scrub along the top layer until 
she grabs the chain with both hands. Right-click 
and choose Split Clip.

7 Trim the top layer
Click to select the second part of the top clip. 
Drag its start point right to trim it down to 1.9 
seconds. This gap reveals some of the parallel 
action on the lower layer.

8 Add POV shot
Select the POV clip where the girl hits the end 
of the zip-wire with a clunk. Drag it to the gap in 
the Timeline’s top layer. Use the ‘clunk’ sound to 
help sync the POV action with the other clips.

9 Fine-tune the start point
Drag the start of the lower layer left to extend 
its start time. Extend the start time of the upper 
layer’s clip, too. Trim the POV clip to reveal more 
of the Front Angle clip.
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1 Import the clip
Go to File>New Movie. In the Create window
choose No Theme. Click Create. Click OK. Click
Import Media. Browse to our GoPro sourced
Timelapse clip. Click Import Selected.

Video footage is usually captured at frame rates such as 25 or 30 
frames per second (fps). When you play the footage the action unfolds at 
a ‘real time’ speed. On the other hand, the timelapse technique captures 
an image at specified intervals (such as one frame every five seconds). 
In a timelapse clip you can see the hands of a clock spin more quickly 
(as you’ll see in our downloadable source clip). It is possible to capture 
timelapse sequences on an iPhone (if it’s running iOS 8) or on specialised 
gadgets such as the GoPro Hero4 Silver. To capture a successful timelapse 
sequence your camera needs to be fixed on a static tripod. Thanks to 
iMovie’s Ken Burns tools you can add more interesting camera moves to 
statically framed timelapse clips.

Add camera moves to timelapse footage
Enhance your statically framed timelapse projects with digitally created zooms, tilts and pans

Difficulty
Expert

Time needed
15 minutes

Step-by-step Add camera moves to timelapse clips

iMovie

2 Add to Timeline
Double-click on the thumbnail in the Event 
window to add a yellow selection border to the 
whole clip. Drag the clip to the Timeline. Play 
the clip to see the timelapse action unfold.

3 Split the clip
At this stage the camera remains static 
throughout. Scrub the playhead until the girl in 
the blue hat is about to exit the frame. Right-
click on the clip and choose Split Clip.

4 Split it again 
Scrub the playhead forward until the lady in red 
is passing the tower. Right-click and choose Split 
Clip. The timelapse clip is now chopped up into 
three sections.

5 Choose Ken Burns
Click on the middle section of the timelapse 
footage. Click on the Cropping icon above the 
main viewer. In the Style section click on the Ken 
Burns button.

6 Choose zoom end point
Click on the End rectangle to select; it will 
change to a white border. Drag a corner handle 
to shrink the size of the End rectangle. Drag 
inside the rectangle to place around the tower.
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Zoom in
Add a digital zoom to timelapse footage

Let’s split
By splitting a single
timelapse sequence into
sections, you can start off
with a wide shot in the first
section and then zoom in
during the second section.
The third section holds a
static, zoomed-in version of
the scene.

  Cropping
The Cropping icon enables you to 
select cropping tools to improve 
composition. By clicking on the Ken
Burns button you can animate the
crop window to start off wide and then
zoom in on an interesting detail.

  Music
To enhance your timelapse footage, 
click the Sound Effects library and 
open the Jingles folder. Drag the Time
Lapse music clip to the Timeline.

Start and End
The Ken Burns tools feature adjustable Start and End
rectangles. You can drag these to specify the position
of the virtual camera at the beginning and end of
each clip. A yellow arrow indicates the direction of the
camera move.

Knowledge base
Size is important
When you use Ken Burns 
to zoom into a close-up 
of a clip, you run the risk 
of making delicate details 
look fuzzy. Our GoPro Hero 
4 enabled us to shoot at a 
high 4K resolution, which is 
much larger than ordinary 
HD footage. This allowed 
us to zoom into the clock 
tower without a noticeable 
drop in image quality. 

7 Test the zoom
Click the blue tick icon to apply the zoom. Play 
the sequence. The camera will zoom in to the 
End point of the middle section. It will then 
jump back out to full frame in the third section. 

8 Copy the zoom
Click on the middle section in the Timeline. 
Choose Edit>Copy. Click on the third section 
and choose Edit>Paste Adjustments>Crop. The 
third section will now also contain a zoom.

9 Adjust zoom start 
Click on the third section. Click the Cropping 
icon. Drag the Start rectangle and place it over 
the End one. Click the tick. Now the third section 
will feature a static zoomed-in frame.
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It has to be said that despite the fact it comes preloaded free on every 
Mac, GarageBand is a bit of a music production powerhouse. Behind its 
unassuming exterior lies a veritable cornucopia of sounds and instruments 
to build your music projects. The selection includes a large number of 
software instruments, from drum kits and orchestral instruments to piano 
and strings. Since these are all modelled in software, it goes without 
saying that a large portion of the library consists of synthesizer sounds, 
from warm, fat analogue basses to soaring leads and thick, layered 
presets perfect for dance music. So in this tutorial, we’re going to look at 
how to mine this rich seam of synth sounds and get some synthsational 
electronic sounds into your tracks.

Create a synth track in GarageBand 
All you budding Giorgio Moroders out there – it’s time to explore the library of synth sounds!

Difficulty 
Beginner

Time needed
15 minutes

GarageBand

Synth satisfaction
Electrify your projects with GarageBand’s keys to success

  Musical Typing
Select this option from 
the Window menu in 
order to be able to play 
the current sound using 
your computer keys as a 
makeshift MIDI keyboard.

  Play it cool
As soon as you create a 
new software instrument 
track, you can play the 
sound assigned to it from a 
connected MIDI keyboard. 
To record a performance, 
simply hit the R key.

  Green for go
Raid GarageBand’s Loop Browser for 
loops with a green icon. These are 
MIDI loops that you can drag into 
your timeline, then change the sound 
assigned to them for a limitless supply 
of prefabricated synth parts.

  Piano Roll
This area, revealed by clicking the scissors button in 
the Transport bar, is where you can change the pitch, 
timing and duration of the notes in your MIDI parts.

Knowledge base
Custom sounds
You can easily create your 
own custom synth presets 
by adjusting the controls of 
existing settings using the 
Smart Controls pane. Once 
you arrive at a sound you 
like, use the Save button in 
the lower-right corner of 
the Library pane to save the 
edited patch to your own 
library, making it accessible 
from other projects.



35

Step-by-step Use synth tracks in GarageBand

1 Project preparation
Working in a new, empty GarageBand project, 
set the tempo to 130bpm, then click the + 
button at the top of the track list in order to 
create a new track. 

2 Choose track type
Click the image of the synthesizer on the left 
to create a software instrument track, allowing 
you to select and play any of the software 
instruments in GarageBand’s library. 

3 Create track
Now click on Create to add the new track to 
your project. The Library pane on the left will 
open up with the default Classic Electric Piano 
preset selected.

4 Browse library
From the Library pane, which contains a menu 
of all the available instruments, select the 
Synthesizer category. Several subcategories will 
appear. We’re going for the Brass section first.

5 Select sound
Click a preset’s name to select it. We’ve gone for 
Emotive Pulse, but not all presets are available 
on all systems, so you may need to download 
additional content via the File menu.

6 Import project files
Import the files ‘GBX Synth Track Drums.aif’ 
and ‘GBX Synth Track Bass.aif’ from our FileSilo 
page by dragging and dropping them from the 
Finder into your project timeline.

7 Import MIDI part
Next, import the file ‘Emotive Pulse.mid’ onto 
the Emotive Pulse track (or you could always 
record your own MIDI part if you prefer). Hit Play 
to hear the result – it needs a little adjustment.

8 Take control
Hit the Smart Controls button to bring up some 
controls for the sound. We want to make the 
sound shorter, so bring the Release control 
down close to zero to achieve this.

9 Adjust effects
Finally, turn up the Delay control to add more 
delay effect to the sound. Alternatively, to try out 
another synth sound, just pick a new one from 
the Library pane and hit Play once again.
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In music production terms, recording yourself and
performance can prove troubling. What happens w
feeds back into sound input? Well, yeah, you get feed
howls or ear-splitting shrieks aren’t always welcome.
course, enables monitoring as you play or sing, but if
speakers rather than headphones, feedback can occu
feedback protection that only enables monitoring du
however this can be toggled as desired. In addition, t
Automatic Level Control and a default Noise Gate plug
cultivating or cutting out noise. Here we’ll quickly high
and what they mean for your projects.

Master feedback and noise protection
How to filter out or encourage feedback and noise when recording

Difficulty 
Intermediate

Time needed
10 minutes

GarageBand

1 Track monitoring
Input Monitoring applies to audio tracks, 
recording microphone or guitar. This can be 
activated via the New Track dialog or from the 
track header and inspector panel.

3 Feedback detected
With the Feedback Protection checkbox 
enabled, GarageBand will mute the monitoring 
and issue warning prompts to highlight that 
feedback has been detected. 

2 Feedback protection
The Smart Controls Inspector has a Feedback 
Protection checkbox that restricts monitoring to 
during recording only. Turn this off should you 
wish to encourage feedback.

4 Noise Gate
The Noise Gate is a default track plug-in. With 
it ‘on’ you use the slider to further filter out 
background noises, typically clicks and signal 
hisses being picked up.

Control the 
recording volume

1Record Level
This slider in the Smart Controls Inspector

sets how loudly the selected input will be
recorded. Increasing this widens the audio
waves, capturing a bigger track sound.

2 Automatic Level Control
Below is a checkbox marked Automatic 

Level Control. Select this to allow GarageBand 
to automatically graduate the recording levels 
for optimal capture, minimising clipping. 

It is also possible to set how loud the recording 
level of your chosen input is, offering more 
control over signal capture.

Step-by-step Feedback and noise protection in GarageBand



Music systems for the 21st century

iPod is a trademark of Apple Inc., 
registered in the U.S. and other countries. www.ruarkaudio.com

To learn more about us or to request a brochure, please visit our website or call us on 01702 601410

As a family owned British company for over 30 years we have 
worked within the revered British audio industry, creating high 
fi delity loudspeakers for music and audio enthusiasts.

Seeing a niche in the market, in 2004 we made a radical decision to 
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audio products. Our aim was to create products with broad appeal 

but capable of sound quality that belied their beauty and compact 
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to everyone and not just hi-fi  enthusiasts. The aim with our MR1 

Bluetooth Speaker System was to create compact speakers, capable 

of giving high quality sound in multiple applications. As speakers for 

computer systems they’re ideal, but they are also equally at home as 

speakers to signifi cantly improve the sound of fl at panel TVs. MR1s 

are also more than capable of providing the basis of a complete music 

system and with Bluetooth and aptX built-in, audio can be streamed 

and played wirelessly with CD-like sound.

made for music

R1 DAB/FM radio

with Bluetooth

R2 tabletop stereo with 

Bluetooth, Wi-Fi and Spotify

R4i integrated music system R7 high fi delity radiogram

Other models also available:
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1 Getting started
As with any new project, head to the template
drawer and select a canvas to use. With the new
page open, head to Chart and select one of the
options listed under Interactive.

Charts, in their many varied forms, are a superb way of visually 
expressing cold hard facts and numerical data, but what if you want to 
show the evolution or changes to that information, for instances over 
time or from various locations, perhaps? Do you create dozens of similar 
graphs to represent all of these different events? Well not if you have 
Pages. With Pages you can generate a professional and visually striking 
Interactive Chart that enables you to present information as a portfolio of 
various, yet similarly themed, graphs that you can quickly and easily flick 
between. The result can be used as a qualitative resource for determining 
everything from profitability to feasibility, simply by comparing the 
outcomes at a quick glance.

Create an interactive chart in Pages
Use Page’s Interactive Charts to show the evolution of your data

Difficulty
Beginner

Time needed
45 minutes

Step-by-step Create an interactive chart

Pages

2 Change the default
Pages will present a default version of the 
Interactive Chart you have selected. Don’t worry, 
you can change this with little fuss. Click on Edit 
Chart Data, which is shown as a blue button. 

3 Table of values
A table will appear with the default values and 
dates. You can now set the values on the X and 
Y axis as well as the corresponding values. When 
you’re finished simply close the table.

4 Flick between
You should see your chart. Pull the slider or click 
one of the incremental steps to move between 
your charts. Under Chart Options in the Format 
panel you can add a Title and key (Legend). 

5 Colours and textures
To add some creativity, add a splash of colour. 
Click on the Chart Colors box in Format and 
explore Colors, Images and Textures to discover 
a range of visuals that best suit your project. 

6 Sliders or buttons?
There is more than one way to swish between 
charts; in fact there are two. Under Interactive 
Chart on the Format panel, you can either opt to 
use Slider and Buttons or simply Buttons Only. 
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Interactive charts in Pages
Discover how to create an interactive portfolio of graphs 

   Make it your own
After choosing a chart style 
you’ll be presented with a 
very basic graph to get you 
started. Hit this Edit Chart 
Data button to find a table 
of values that will enable you 
to add your own information 
to make it as complex or as 
concise as you want. 

   Chartastic
When creating a chart 
you’ll need to head up to 
this Chart icon to begin. 
Here you’ll be presented 
with a range of 2D and 3D 
options, but you’ll want 
to select one under the 
Interactive section. 

   Format
The Format panel holds a wealth of 
tools and options, ready for you to 
make the Interactive Chart your own. 
You’ll find colour options, font choices, 
graph styles and design controls here, 
so get experimenting!

   Slider and buttons
You can pick to flick between your graphs with a slider 
and buttons, or just buttons (see step 6). To move the 
slider simply click on the white ball and drag it left 
or right. Alternatively hit one of the ‘buttons’ used as 
incremental markers. 

7 Design dilemma
You can change the type of Interactive Chart 
you use, even after you’ve added in all your 
data. Head to Chart Type and choose between 
Interactive Column, Bar, Scatter or Bubble.

8 Change of mind
If you feel your information would be better 
presented as one all-encompassing chart, rather 
than a collection, you can select any option 
from the Chart Type list at any point. 

9 Send and share
As with all Pages documents, you can send 
it and share it with others. Head to the Share 
icon at the top of the interface and choose an 
appropriate mode of delivery.

Knowledge base
Columns of power
When creating your chart 
it’s important to remember 
that it’s the information 
presented in the columns, 
not the rows that change 
from one graph to the next. 
So the number of columns 
you have will determine 
the number of interactive 
charts you have in your 
portfolio. Therefore if you 
want to include more charts 
in your collection, you’ll 
need to add more columns 
of data in your chart table. 
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Keynote’s ability to implement media into presentations is what helps 
make it a standout app. Keynote enables you to feature music, images, 
video and animation within your slides in whatever manor you deem fit. 
Keynote also enables you to edit video files. This is especially useful if you 
want to include only a section of a clip in your presentation. You can even 
adjust your playback settings for videos in Keynote, determining whether 
a clip plays through just once or loops continuously. 

It’s worth noting that when working with video in Keynote, it’s best to 
have an edited video to start with. Trying to import a massive unedited 
video file to then edit down will slow your presentation and drastically 
increase the overall file size. 

Add and edit video in Keynote
Help your presentation slides stand out with extra video elements 

Difficulty 
Beginner

Time needed
30 minutes

Keynote

Movie settings
Adjusting and improving your video in Keynote  Animation and transitions

The Animate tool can be applied to video 
files enabling you to transition a video into 
your slide, as well as being able to apply 
various other special effects to the video. 

 Style options
Click on the Style tab to 
change the border, shadow 
options and opacity of a 
video, just as you would 
any other object, animation 
or media file. 

 Volume control
The master volume control will determine the overall 
volume of your video and is not affected by the 
volume that you set your Mac to. Only adjust this if 
your video is too loud.

 Playback options
With the ‘Start movie on click’ option selected, 
Keynote will wait for your cue to begin playing the 
movie. Alternatively you can uncheck this and Keynote 
will play the video as soon as you go to its slide. 

Knowledge base
File management
If you are planning on 
running your presentation 
on another Mac, then make 
sure you take your video 
file with you. Once you’ve 
got the presentation set 
up, you can then locate 
the video file. If your video 
is too large and is running 
slowly in Keynote, open it 
in QuickTime. Go to File> 
Export for export options to 
reduce the file size. 
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Step-by-step Control video within Keynote

1 Video formats
Make sure the video you want to use is 
compatible with Keynote. Compatible file types 
include QuickTime, MOV and M4V. Look at the 
extension of the file type to find out the format.

2 File sizes
Right-click a file and click Get Info. At the top of 
the window you’ll see the file size. Ideally you 
would want to keep your video below 200MB to 
avoid slowing down your presentation. 

3 Import to Keynote
Move the video file into your Mac’s Movies 
folder. Open your Keynote presentation then 
click Media>Movies in the top bar. Click the 
Movies folder and you will find your video file. 

4 Basic video tools
Click the video thumbnail for it to be placed into
your current slide. Click the video to select it, 
and click the play icon to begin playing. Use the 
corner pins to resize the video. 

5 The Movie tab
With the video selected, click the Movie tab in 
the right-hand toolbar. Here you can adjust the 
volume and playback of a video. Click Edit Video
to view trimming options for your video. 

6 Trim your video
Click and drag on the start and end pin of the 
trim bar to change your video’s start and end 
points, enabling you to quickly edit down the 
duration of the video within Keynote.

7 Set an image
By dragging the Poster Frame slider you can 
select which freeze frame image is used on the 
video when it is not playing. This can be any 
frame within the film.

8 Video replacement
If you’ve updated your video and need to 
replace it with a newer version, click Replace 
under the File Info subheading and locate the 
new video file that you want to replace it with. 

9 Preview your presentation
Click play in the top tool bar of Keynote. Click 
on the video to begin playing it. A playback bar 
will appear at the bottom of the video for you to 
stop and start the movie. 
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Drum replacement is a fairly specialised technique whereby one 
element of a multi-tracked drum performance – usually the kick or 
snare drum – is replaced by a sample triggered from the original part. 
The new sound can either be mixed in to beef up the original, or used in 
its place to replace it entirely. 

Once the preserve of big studios with expensive setups, the advent of 
Logic Pro X means that it’s never been easier to either double or replace 
dodgy kit pieces when fixing up drum recordings. Once converted to 
MIDI, you can swap samples, edit note velocity and even requantise the 
part. Apple’s Pro DAW now even has a dedicated tool for this very task, 
and over the next two pages we’ll show you just how to use it. 

Replace dodgy drum kit sounds in Logic
Substitute inferior drum sounds with Logic’s clever drum replacement feature

Difficulty 
Advanced

Time needed
20 minutes

Logic

Replacement service
Swap iffy drum sounds for brand new samples

 Timing offset
The process can sometimes 
knock the timing of each 
drum hit off by a consistent 
amount. If so, use this slider 
to compensate and pull 
things back in time.

 Replace or double
If you choose Replacement, 
Logic will mute the original 
track when it creates 
the new MIDI part. With 
Doubling selected, it leaves 
it as it is and the new MIDI 
part can then be blended 
with the original.

 Velocity control
If desired, iron out all the drum hits to the same 
velocity by selecting them all in the Piano Roll editor 
and holding down the Option key while using the 
Velocity tool on one of the hits.

 Set average attack time
The MIDI trigger notes are normally placed exactly 
at the transient timing positions. This button sets an 
average slicing position offset of all regions on the 
source audio track.

Knowledge base
EXS for success
The new sounds are 
played back via a freshly-
created EXS24 Sampler 
by default, but you can 
load up any other drum 
plug-in to use as the 
source of your new sound. 
Logic’s own Ultrabeat 
or Drum Kit Designer, or 
third-party Audio Units 
such as FXpansion’s BFD, 
Drumagog and Toontrack’s 
EZdrummer also work well.

FileSilo
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Step-by-step Fix dodgy drum sounds

1 Load project
The first job is to load up the LPX Drum 
Replacement project included in the Tutorial 
Files folder on our download site. It should 
appear as shown above.

2 Select target
Click to highlight the track that you want to 
replace. Here we’re targeting the snare drum, as 
it’s tuned a bit too high in pitch and rings out 
too much.

3 On the menu
Select Track>Replace or Double Drum Track. 
Logic will analyse the target track for transients – 
peaks in the audio waveform that represent the 
drum hits that need to be replaced.

4 Type approval
In the options window, first select the type of 
instrument you’re going to replace. Since we’re 
replacing the snare, we select Snare from the 
pop-up menu.

5 Set threshold
Use the Threshold slider to set the audio level 
above which snare drum transients will be 
detected. There’s a fair bit of kick drum bleed on
this snare track, so we set it quite high, at -7.9dB.

6 Gauge sensitivity
When the MIDI events you can see in the new 
green region match up with the peaks in the 
snare’s audio waveform, you’ll know that the 
threshold is set about right.

7 Set trigger note
Use this menu to choose the note that the 
generated MIDI part will play; most snares are 
found on D1, for example. The Auto setting 
accounts for this, so leave this set for now.

8 Select new sample
Choose the sample that you want to trigger 
from the list that appeared when the Library 
pane opened in step 3. Click on a sound and 
use the Prelisten button to audition it.

9 Replace
Select the Replacement option and click OK. 
Logic mutes the original audio and creates a 
new MIDI track to replace it, named the same as 
the original but with a ‘plus’ added.
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There’s a lot to get right when shooting manually. A generation 
of point-and-shoot photographers don’t need to worry much about 
aperture, focus and white balance. But for those who use more powerful 
cameras than the iPhone, these challenges are essential to master in 
order to get the perfect image. Getting the white balance wrong leaves 
an image looking cold, engulfed in a blue filter you don’t want. This is 
because your camera has failed to render neutral colours correctly. Using 
Aperture’s White Balance tool, you can change the overall mixture of 
colour in an image, creating an effect that looks warm and natural. We’ve 
put the two images we’re using on our FileSilo pages so you can have a 
go yourself. Say goodbye to looking like a Smurf!

Fix white balance issues in Aperture 
Forgotten to set the white balance correctly? You need Aperture’s pro-level tools to fix it

Difficulty 
Intermediate

Time needed
20 minutes

Aperture

Fighting poor colour balancing
Say goodbye to horrible colour casts 

  Reading the 
histogram

Understanding how to read 
the histogram will give 
you an at-a-glance reading 
of your image. The sharp 
peaks here lets us know 
that the portrait is too 
bright and overexposed.

  Loupe details 
Aperture lets you manually 
set the white balance of 
an image by selecting a 
neutral grey pixel with the 
loupe function. Click and 
drag to move around. 

  Slide to adjust 
Aperture’s Adjustment panel hold a wealth 
of powerful editing capabilities. The Warmth 
slider in the White Balance drop-down produces 
immediate improvements.

  Revert to Original
There’s no sure-fire solution when it comes 
to image editing. Invariably you’ll make edits 
you’re not happy with. If this happens, you 
can click Revert to Original at any time.

Knowledge base
Can my Mac make 
these edits?
Most of the editing 
you do in Aperture is 
processor-hungry. Anyone 
running a Mac with 
basic specifications may 
struggle and experience 
slower processing speeds 
because Aperture takes full 
advantage of your Mac’s 
GPU, CPU and RAM. A 
desktop will invariably run 
quicker, but any MacBook 
with 4GB RAM should be 
fine. Oh, you’ll need OS X 
10.10, too. 

FileSilo
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Step-by-step Fix white balance issues

1 Adjustments panel 
Download either of the images on FileSilo and 
import to your Aperture library. Select the image
and head over to the Adjustments tab situated 
at the top-right of the app’s main sidebar. 

2 Hit Auto 
The White Balance tool sits at the top of the 
Adjustments panel. For a quick fix, select the 
Auto option. This offers a one-click adjustment, 
which automatically improves colour. 

3 Add effect 
Or you can add a White Balance effect to the 
image. Head to the Effects drop-down menu to 
see the different options. You get a live preview 
to the right. This Daylight effect works well. 

4 Work manually 
These quick fixes provide decent results, but 
work manually to get a professional standard. 
Move the Warmth slider to the right and see 
natural colour added to the face.

5 Use loupe
Select the White Balance eyedropper tool and 
click on a portion of the image (with the loupe) 
that contains neutral grey pixels, and Aperture 
sorts the white balance for you. 

6 Click and drag
Getting the right colour can be tricky, but 
Aperture makes it easy to test out your image by 
enabling you to click and drag over the image 
with the loupe and view live results as you drag. 

7 Pixel perfect 
Or, if you’re still struggling, you can get up close 
and personal by zooming into your image. This 
ensures you get the best chance of eradicating 
digital noise in the target area.

8 Temperature & Tint 
The Temperature & Tint drop-down gives you 
even more options to counteract a poor white 
balance. Experiment with the two sliders to find 
a pleasing result. Editing is non-destructive. 

9 Comparison 
You can use the original image as a point of 
comparison by hitting M on your keyboard. 
Toggle between your edit and the original as 
much as you feel you need to.



Providing a good-quality sound edit for your movies is as 
important as well-cut visuals. The two go hand in hand, but too 
often sound is overlooked in an edit. Dialogue, SFX and music 
can be edited and mixed in Final Cut Pro using the audio tools 
provided, but if you want to take your audio mix to the next level, 
it’s definitely worth exporting your edit’s audio to Apple’s Logic Pro 
X audio-editing software. Your edit sequence in Final Cut Pro can 
be exported as an XML file. This file type enables you to transfer the 
data within a Final Cut sequence into other software such as Logic 
and to replicate that sequence. The file only contains data; not actual 
audio or video media.

Export Final Cut projects to Logic
Learn how to mix and master your Final Cut Pro projects in Logic Pro X’s advanced suite 

Difficulty
Advanced

Time needed
15 minutes

Step-by-step Transfer audio from Final Cut Pro

Final Cut Pro X

1 Exporting audio
In Final Cut Pro you can export audio only by 
clicking File>Share>Export file. Click Settings, 
and next to Format select Audio Only. Pick a file 
format, then click Next and select a destination. 

2 XML exports
In Final Cut Pro go to File>Export XML. By 
default the XML file is titled as the current date. 
Click Save and the XML file will instantly be 
saved to your computer. 

3 Create a Logic project
Open Logic Pro X. Go to File>New. Click Audio 
and select how many tracks you have in your 
Final Cut project. Click Create to create a new 
project timeline in Logic.

4 Import your XLM file
Time to get the file in place. In Logic, go to File> 
Import>Final Cut XML. Locate the XML file that 
you exported from Final Cut Pro, select it and 
then click Import. 

5 Sample rates
Logic may automatically change the sample rate
of its project to match the XML file that you’re 
importing. This will ensure your audio does not 
go out of sync when placed back into Final Cut. 

6 Frame rate
You’ll be asked if you want to adjust the frame 
rate. Select the one that matches your Final Cut 
project to avoid audio sync problems when you 
return the audio to Final Cut. 
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Deciphering XML code
How to read XML in Text Editor

  Audio rate
Next to audioRate= you 
will find the set frequency 
of the audio in the Final 
Cut sequence that you 
exported this XML file 
from. In this case the 
frequency is 48,000 and 
should remain like this. 

  Other information
You can also find out the amount 
of audio channels in a sequence, 
the video format, file destinations 
and video codec information from 
the XML file. You can even edit the 
information manually. 

  Frame rate
Next to srcFrameRate= you’ll find the frame rate of 
your sequence. You will want to make sure that any 
projects you set up with this XML file match this same 
frame rate. 

Knowledge base
What is an XML file?
XML (Extensible Markup 
Language) files are able 
to transfer data between 
software that would 
otherwise be incompatible. 
Since you can’t simply open 
a Final Cut Pro file in audio 
software such as Logic Pro 
X, an XML file will tell Logic 
how to build a project using 
the same files seen in the 
Final Cut sequence that the 
XML file was exported from. 

  XML coding
XML files can be opened in 
Text Editor. From here you 
can find information on 
your Final Cut sequence to 
help you when importing 
the XML file into other 
software such as Logic.
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7 Edit your audio
Once the XML file has been fully imported into 
Logic, you will see the audio placement within 
the Logic project is exactly the same as that of 
your Final Cut Pro project. 

8 Import new footage
In Logic go to File>Movie>Open Movie. Locate 
the video file you exported from Final Cut Pro 
alongside your XML file. The video will then 
appear in your Logic timeline.

9 Export from Logic
Click File>Export>Project to Final Cut Pro XML. 
You don’t have to worry about including video 
in the export. Select the Compound clip to 
group all tracks together. Click Save to export.
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As computers become smaller and lighter, we can be flexible enough 
to work anywhere (local coffee shop, anyone?). However, there is one 
pitfall that is often overlooked: security. How safe is your data when you’re 
out with your Mac in public places? It’s not only your Mac that might get 
stolen when you’ve nipped to the loo… it’s your data as well.

This is where FileVault comes in – built-in security standards employed 
by governments worldwide, it enables you to encrypt your data so 
that only you can access it. So if your Mac is lost, stolen or hacked, your 
data is safe. Before using FileVault, though, you need to think carefully 
about whether you really need it, as you risk losing all of your data if the 
encryption goes wrong at any stage. Here’s how it works.

Set up and use FileVault 
Protect your personal data when you’re out and about using super-secure encryption

Difficulty 
Intermediate

Time needed
60 minutes

FileVault

Security & Privacy made easy
Take a closer look at the Security & Privacy preferences

 General
Implement basic security 
features for your Mac such 
as disabling automatic 
login, the ability to lock 
your screen, requiring a 
password to access your 
Mac after sleep mode and 
who you can download 
your apps from.

 Privacy
Take control of who has access to 
your private data such as contacts 
or location. Click on the Privacy tab 
to view categories to view, add and 
remove all of the apps that have access 
to this information.

 Firewall
Phishing, malware and viruses 
are becoming all too common on 
computers and even Mac users aren’t 
immune. Activate Firewall and click the 
Firewall tab to control what comes in 
and goes out of your Mac.

 Advanced
Click the Advanced button in any of the Security 
& Privacy tabs to access general security settings 
such as automatic logout and the requirement of 
a password to access and change system-wide 
preferences for your Mac. 

Knowledge base
Encrypt your backups
If you have reason to 
encrypt the data on your 
Mac, it would be wise to 
encrypt the data on your 
backups, too. When setting 
up Time Machine, you 
can choose to encrypt the 
contents of your backup by 
double-clicking on the hard 
disk you’re backing up to 
and then checking the box 
marked ‘Encrypt backups’ 
from the pop-out window 
that appears.
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Step-by-step Set up and use FileVault

1 Launch System Preferences 
To get started, click on the Apple logo in the 
top-left of your desktop and choose System 
Preferences. Or, navigate to your Applications 
folder and find System Preferences in there.

2 Open the preferences
In the System Preferences pane, select Security 
& Privacy from the top row of icons, which will 
launch the Security & Privacy preferences pane 
for your Mac. Next, click on the FileVault tab. 

3 Show your credentials 
Click on the padlock icon in the bottom-left. 
When prompted, enter your Administrator 
username and password. You must be an 
administrator to secure your Mac using FileVault.

4 Back up your data
Before you proceed, double-check that you 
have a recent backup, as you won’t be able to 
perform a full back up after this point. Next, click
on the Turn on FileVault button. 

5 Remember your recovery key
A recovery key will be displayed on the screen. 
Write it down and keep it safe; you will need this
to decrypt (remove) FileVault if you forget your 
password in the future. Press Continue. 

6 Entrust your key
Apple gives you the option of storing your 
recovery key with them to protect your data if 
you lose it. If you wish to do this, select ‘Store 
the recovery key with Apple’ option.

7 Create security questions
You’ll be prompted to create security questions 
and answers: choose a question from the drop-
downs and enter answers. Be aware that Apple 
only accepts exact answers to recover your key.

8 Activate FileVault
Once you’re all set, press Continue. Your Mac will 
restart and begin the initial encryption process. 
Don’t force power off your Mac during this 
process otherwise you may lose all your data.

9 Carry on encrypting
FileVault will continue encrypting after you’ve 
logged back in. This can take minutes or hours, 
depending on how much data there is. Head 
back to the FileVault pane to check progress.
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1 Download AirParrot 2
Head to www.airsquirrels.com/airparrot and
purchase a license (£9.99/$14.99) for AirParrot
2. Once downloaded, install it. AirParrot can be
found in your Applications folder.

If you’ve got an old Mac that isn’t compatible with AirPlay but want
to reap the benefits of mirroring your display to your TV, don’t throw
your Mac away just yet – take a look at AirParrot 2. This bit of software
enables you to mirror your Mac’s display to your TV via devices such as
Apple TV – or if you prefer to use something more cost-effective – the
Google Chromecast device. It also streams audio directly from your Mac to
your TV or speakers with wireless capabilities around your house. Perfect if
you’re entertaining guests! AirParrot 2 also enables simultaneous mirroring
to multiple devices, which means that you can stream a video or some
music to multiple screens around your house. Let’s take a look at how you
can get started.

Wirelessly share media with AirParrot 2
Mirror what’s on your Mac’s display to your TV via your Apple TV or Chromecast device

Difficulty
Intermediate

Time needed
10 minutes

Step-by-step Wirelessly mirror your Mac’s display

AirParrot 2

2 Install display drivers
When launching for the first time, you may be 
asked to install a display driver: this will help 
AirParrot 2 run correctly. Click on Install Display 
Driver. You’ll then need to reboot your Mac.

3 Choose your mirror
Getting started with streaming is easy. Click on 
a display you want to stream from (more than 
one display shows if you’ve got multiple displays 
connected to your Mac).

4 Which display?
If you’ve got multiple displays connected to 
stream from and you’re not sure which display is 
which, hover your mouse over the display in the 
list and it will be outlined in green. 

5 Choose your destination
Next, you need to choose where you want to 
stream your display to. Under the To heading, 
click on the device that you wish to stream to, ie 
Apple TV or Chromecast.

6 Stream your browser 
If you want to only the stream the contents of 
one app such as Netflix or Spotify via an internet 
browser to your TV, click on Applications and 
select the app from the pop-out menu.
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Make the most of AirParrot 2
Get to grips with AirParrot 2’s interface

 Stop mirroring/play/pause
To pause streaming temporarily, or to 
stop altogether, use the Switch and Play/
Pause icons. Clicking the Switch icon will 
completely stop all streaming, while the 
Play/Pause icon will temporarily pause 
and resume streaming.

 Show/Hide cursor
The mouse cursor is pretty annoying – 
especially if you’re trying to stream or 
look at photos. Clicking on the mouse 
cursor icon will hide the cursor on the 
TV that you’re streaming to.

 Control master volume
TV volume too loud or too quiet? 
Control the audio being streamed 
to your TV via AirParrot 2 using the 
volume slider so you don’t deafen 
yourself and everyone around you.

 Access settings 
Set up and access preferences for AirParrot 2 such 
as adjusting streaming quality and frame rate, check 
for the latest updates and get help and support for 
AirParrot 2 by clicking the cog.

7 Choose your tab
If you want to stream from an internet browser 
and have multiple windows or tabs open in that 
app, you can select which window or tab you 
want to stream wirelessly to your TV.

8 Stream your audio
Alternatively, if you’ve got guests, you can easily 
stream music from your Mac to your TV to keep 
them entertained. Click Audio Only and choose 
which audio channel is to be mirrored.

9 Stream only media
Lastly, you can choose to stream a media file, 
such as a movie, to your TV. Select Media and 
click Open to find the file that you want to 
launch and stream to your TV.

Knowledge base
Fixing any lag or 
quality  issues
Experiencing lag with 
AirParrot 2? There are a few 
fixes you can try. Click the 
cog in AirParrot and select 
Preferences. Reduce the 
Video Quality and Frame 
Rate by dragging the 
relevant sliders to the left 
until your stream becomes 
stable. AirParrot uses your 
Wi-Fi connection, so make 
sure your router is free of 
any obstructions.
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When attempting to transfer large quantities of fil
your Mac, you can be forgiven for not correctly lab
time. However, there’s an easy system to fix this issue
also having a plethora of additional options at your d
single menu. By right-clicking on a file and selecting t
separate panel will appear on your screen. 

Here you’re able to change a surprising amount of
said file that you wouldn’t normally consider when yo
across. In this tutorial, we’ll guide you through some o
disposal when using this menu and what you should
away. Let’s get started.

Explore the Get Info panel
Learn how to correctly label your files and much more

Difficulty
Beginner

Time needed
10 minutes

Step-by-step Edit information in Get Info

Finder

1 Open the panel
Select any file currently on your desktop and 
right-click on it. From the menu that now 
appears, select the Get Info panel. You’ll be able 
to see an overview of the file. 

3 Leave comments
The Comment tab is ideal if you need to leave 
little notes to yourself. For example, it’s a great 
place to mention if an image needs some 
editing work done to it.

2 Add tags
Adding tags can make it easier to identify the 
file in a crowded Documents folder. Select from 
various colours, or create your own tags at the 
top of the Get Info panel.

4 Set default program
For images especially, you’ll find the default 
program they open in is Preview. However, 
select the Open With option and you can 
change this to iPhoto or another editing app.

Grant and restrict 
permissions

1Select a contact
Press on the + icon at the bottom of the Get

Info panel to add a contact who can access this
file. Everyone stored in your address book will
appear on a new menu.

2 Grant permissions
Once you’ve selected a contact, press on 

the up and down arrow icon next to their name. 
This will enable you to grant them specific 
permissions for that file.

The Get Info panel is an easy way to let contacts 
have access to specific files and folders stored 
on your Mac.
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If you’re a prolific iTunes user, chances are you’re going to have a vast 
library to explore and use. Although the choice is nice, it does leave you 
with a lot of clutter to deal with if you don’t listen to some of the older 
songs attached to your account. Users can delete tracks from their iTunes 
library, but this leaves them with no options when they want to add them 
back to their account at a later date. Instead, by downloading the iBatch 
app, users can create a virtual archive of songs they no longer want and 
remove the entry from their library. However, if they then change their 
mind, it’s possible to add the archived songs back to your account in a 
matter of minutes. Here’s how it’s done.

Archive iTunes tracks with iBatch
Keep your iTunes library tidy by removing and backing up unwanted tracks

Difficulty 
Intermediate

Time needed
20 minutes

iBatch

Manage media in iBatch
Explore iBatch’s impressive feature list

  Return to iTunes
To reverse the archiving 
process and return albums 
to your iTunes account, 
select the Add to iTunes 
option. This will reverse the 
process and a new listing 
will be added to your 
iTunes library.

  Switch folders
If you’re looking to archive a large 
number of songs, consider splitting 
the archives into different folders to 
make them easier to navigate. Use 
the Change Folder icon to set a new 
archiving folder on your hard drive.

  Archive
Once you’ve highlighted a song or 
album, use the Archive button to 
remove it from your library and on to 
your iBatch account. Depending on the 
number of songs, archiving shouldn’t 
take very long.

  Move to Trash
If you decide you no longer want an album 
you’ve archived, use the Move to Trash option to 
permanently remove it from your library. The album 
will be sent to the Trash app for you to delete.

Knowledge base
Not in the cloud
If you’re actively using 
iTunes in the Cloud, then 
you’ll have some difficulty 
archiving albums. Instead, 
you’ll need to download 
any songs from the cloud 
and archive them as per 
the instructions in this 
tutorial. If you then return 
the archived album to 
your iTunes account, add 
them straight to your cloud 
account once again.
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Step-by-step Archive tunes with iBatch

1 Scan library
Open up your iTunes account and make a 
mental note of all the albums you want to 
archive. Use the Albums tab to reformat your 
library to show the ones you want to see.

2 Sync with iBatch 
Load up iBatch and follow the setting up 
instructions that are provided. It should 
automatically sync with your iTunes account and 
show the Ready icon when usable.

3 Set up archiving
Select the Archive tab from within iBatch. When 
you first access the menu, all the options will 
be blanked out until you add an archived song 
folder near the bottom of the menu.

4 Create a folder
Select the Create Archived Folder option and 
go ahead and add a new folder onto your hard 
drive. Once done, head back to your iTunes 
account and select a song.

5 Start archiving
As you select a song, the name and artwork of 
it should be shown within iBatch. Press on the 
Archive button once you’ve selected the songs 
and wait for the archive to finish.

6 Make a list
When you add further songs to your archive 
library, you’ll see folders and artists appear in the 
iBatch window. Use the Refresh List option if not 
all stored songs are appearing.

7 Move to Trash
If there is a song you’d rather permanently 
delete, select it within iBatch and press the 
Move to Trash option. This will remove the 
archive completely from your Mac.

8 Edit details
If certain songs aren’t being stored in the correct 
genre while in iBatch, use the Album button 
to change some of its details. The song should 
automatically reformat itself.

9 Create a backup
Backing up large quantities of albums is quicker 
than manually archiving. Select the Backup 
option and add all the songs you’d like to back 
up to your Mac.



Safari

Troubleshoot lag issues in Safari
Solve slowdown issues while browsing with Yosemite’s default web browser

1 Open Preferences
Select the Preferences tab from within the Safari
browser. From the new menu that opens, select
the Extensions option that’s located on the right
side of the menu.

2 Manage extensions
Extensions can be one of the biggest influences
when it comes to causing lag in Safari. Disable
any you suspect to be causing the issue, or turn
the option off altogether.

3 Remove data
Now select the Privacy option from the same
menu, before choosing the Remove Website
Data option. This deletes any of the data that
has been previously added to websites.

4 Clearing cache
The final phase of solving lag issues is to delete
the cache. Firstly, open the Finder on your Mac
and select the Go to Folder option underneath
the Go tab on the toolbar.

5 Go to the folder
A text bar will open and you’ll need to enter the 
following: ~/Library/Caches/com.apple.Safari/
Cache.db to be taken to the cache file that will 
need to be deleted.

6 Delete cache
Several variations of Safari’s cache file will be 
listed, but you’ll need to move the file named 
Cache.db to the Trash. Restart Safari and your 
issue should be fixed.

After prolonged use, chances are you’ll come across some noticeable 
slowdown when using the Safari browser on your Mac, especially in 
Yosemite. Although it’s easy enough to simply ignore it, after too long it 
can dramatically affect how the browser functions, so it’s essential that 
you tackle the problem as soon as you come across it. 

There are numerous myths around that explain different methods of 
solving your lag woes, but most of them simply won’t work, and in some 
cases, can be detrimental to your Mac. However, we’ve put together a 
guide of some of the best ways to fix any slowdown issues you may be 
having with the Safari browser. Most can be done in just a few minutes, so 
read on and get Safari running at full speed once again.

Difficulty 
Intermediate

Time needed
15 minutes
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Step-by-step Solve lag problems in Safari



Switch search 
engines

1Open the Search menu
Select the Preferences while in Safari and

then scroll to the Search section. By default, you
should find that your search engine is set to
use Google. Press on the arrow icon in order to
change all of this.

2 Switch engines
Safari will now display some alternatives 

for you to use. Each has their own strengths 
and weaknesses, but we recommend Bing as 
being one of the quickest search engines on the 
market today.

If you want to explore every way to increase the speed 
of Safari, then you’ll want to take a look at switching 
your default search engine. Although the changes 
aren’t massive, each search engine on offer takes 
a different amount of time to process your search 
and show the results. Use these tips to switch search 
engines within the Safari browser.

“Take a look at switching 
your search engine”
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Manage cookies and data
Keep Safari running at optimum speed

 Disable tracking
By preventing websites 
from tracking your data, 
you can save snippets of 
information from causing 
slowdown in the browser. 
Make sure the box isn’t 
ticked at the bottom of the 
Privacy menu.

 Block cookies
To permanently prohibit 
websites from storing 
cookies, select the Always 
Block option at the top 
of the Privacy menu. This 
should instantly reduce 
any slowdown issues that
you’ve encountered.

 Remove data
Select the Remove All Website Data 
option to delete all the cookies 
that have been stored from them. 
Depending on how many websites 
you’ve accessed, deleting could take a 
while to complete.

 Take a closer look
Instead of completely deleting all stored cookies, 
users can select the Details option that’s provided and 
then individually choose the websites to be removed.

Knowledge base
Streamline Favorites
Although it’s a great 
option to be able to store 
all your favourite websites 
in Safari, it can impact on 
how quick Safari navigates 
between sites. It’s advised 
to streamline how many 
links you save to minimise 
the impact it has on your 
browsing experience. Open 
up the Favorites menu 
to delete any that are no 
longer needed.
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Pixelmator

1 Select image
With Pixelmator open, head to the plus sign in 
the top-left corner and select an image that has 
been ruined by a blemish or stray object from 
the long list of available sources.

2 Retouch
Pixelmator offers a grand selection of editing 
tools that live under the Tools menu. You can 
see some highlights in the boxout on the 
opposite page, but we want to select Retouch. 

3 Repair tool 
Select the Repair tool in the top-left. This tool 
will let you remove unwanted objects. When 
you select the tool, your image will load up on 
the screen ready to be tweaked. 

4 Select brush size
You’ll need an appropriate brush size. If you’re 
removing large objects, a larger brush makes 
sense, but most edits will use smaller ones. Set 
the size precisely with the percentage slider. 

5 Remove blemishes
Zoom in on your image with your thumb and 
finger to make blemishes easier to see, then 
brush over the troublesome area and watch it 
blend seamlessly into the background. 

6 Remove objects and admire
It works just as well when removing large 
objects like birds. Brush over the object as 
before and wait for the edit to process. Admire 
your work and hit Done in the top-right.

Remove blemishes with the Repair brushStep-by-step

It’s happened to us all despite our best efforts. You think you’ve taken 
the perfect picture, only to notice a stray pigeon in the shot or dust on 
your lens. It’s mightily frustrating, but there is a way to fix it, and thanks to 
Pixelmator’s superb set of editing tools, it’s much easier than you might 
imagine. From the Retouch menu, you’ll select the Repair tool, which 
works to remove blemishes and unwanted artefacts by blending the stray 
pixels into the destination area. Pixelmator enables you to increase and 
decrease the size of the brush, but advanced control like opacity settings 
are not present. Don’t let this put you off though, Pixelmator for iPad is 
supremely powerful and represents your best bet for blemish-free images. 
Here’s how it’s done in six straightforward steps.

Remove blemishes with Pixelmator
Use Pixelmator’s multi-purpose Repair brush to get rid of unwanted elements

Difficulty 
Intermediate

Time needed
15 minutes



67

What else can you do in Pixelmator for iPad?

Adjust colour
Got an image that’s looking drab? You
can boost its colours in no time at all. 
Pixelmator has a few preset settings, 
but also individual Brightness, 
Contrast and Saturation sliders will 
ensure you get the right results.

Brushes
Pixelmator’s brushes menu, found 
under Paint and Erase, make this is 
a standout app. There’s a massive 
choice to get creative with, and the 
Eraser tool and all its variations does 
exactly what it says it will.

Adding effects
It may be a bit too ‘Instagram’ for 
many users, but anyone looking 
for a quick fix can head to the Add 
Effects menu and select a filter. You 
do get secondary controls to alter the 
strength and direction of the effect.

Cropping
Getting the perfect composition is 
a lot harder than it seems. With so 
many variables that can enter a busy 
photo, you’ll want Pixelmator’s Crop 
and Straighten tool to do all the hard 
processing work for you.

 Non-destructive
All edits you make in Pixelmator are 
non-destructive, which means you 
can revert to the original image at any 
time. Pressing Undo will delete the 
previous edit if you don’t like it.Knowledge base

Work with a stylus
There’s only so much that
your finger can do when
it comes to touchscreen
editing. A more dexterous
alternative would be to
use a stylus, giving you
greater control and success
when it comes to removing
blemishes. Check out our
stylus group test on page
80 for our pick of the best.

 Brush size 
Invariably you will want to use a small 
brush size to make edits, but you can 
easily change its size from the menu 
bar. There’s four preset settings and a 
slider to get more precise.

 Retouch 
Pixelmator has a host of editing tools, 
but here we’re using the Retouch 
tool. You’ll find it under the Repair 
menu and it gives you stunning results 
in seconds.

 Processing 
In this image we’re getting rid of a large blemish 
by the little girl’s rear. This is complex and powerful 
editing, which doesn’t happen instantly. You’ll need to 
wait of couple of seconds.

Complex edits made easy
Remove background distractions in seconds
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Tracking is an easy way for advertisers to target certain apps, adverts 
and other miscellaneous data directly to your device. With location 
tracking you’ll find adverts appearing when you browse the web, 
highlighting things in your local area, or places that you’ve recently visited. 
Although most of these adverts are fairly unobtrusive, some can be a little 
more annoying. To combat this, it’s important to have a correctly set up 
location tracking system on your iPhone. 

Through the iPhone’s Privacy menu, users are able to toggle with a 
whole host of different settings that can limit and prohibit various apps 
and services from sending their location, or thanks to Apple, completely 
turn location tracking off. In this tutorial we’ll guide you through the 
fairly complex location tracking menus. There’s a surprising amount 
of information to take in for this one thing, but by following the steps 
provided we’ll have you set up in no time at all.

Master location tracking 
on your iPhone
Set up and manage how your iPhone shares your 
location with others

Difficulty 
Intermediate

Time needed
15 minutes

Settings

1 Privacy settings
Open up the Settings app on your iPhone and 
select the Privacy tab from the list. On the next 
screen you’ll need to scroll down and select the 
Location Services menu. 

2 Location Services 
At the top of the Location Services menu you’ll 
find a toggle to disable location tracking. Instead 
of permanently disabling it, select an app from 
the list below.

3 App privacy
You can prohibit individual apps from having 
access to your location by selecting Never from 
the next menu. Apps like Maps and Bing will 
require access to function properly.

Step-by-step Set up location tracking
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4 Share My Location
Head back to Location Services and select the 
Share My Location option. This option controls 
if your location details are sent when you send 
any sort of message.

7 Frequent Locations
After turning off the various tracking platforms 
within this menu, select the Frequent Location 
option that appears at the very bottom of the 
list to continue.

5 What device?
Go ahead and select the device you want your 
location to be sent from, or toggle the option 
off completely if you’d prefer to keep your 
anonymity when dealing with messages.

8 Recent history
Your most recent tracking history will be 
provided here, so select it to take a closer look. A 
map overview will now be shown, as well as the 
times you were tracked.

6 System Services
Go back to the Location Services menu and 
open System Services. This is the main crux of 
all the location-based tracking. Toggle off the 
options you don’t want enabled.

9 Clear History
To remove the location history, either select the 
Clear History button that’s provided, or simply 
toggle the Frequent Locations option found on 
the main page to off.
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The default Camera app on your iPhone has some great features, but
perhaps doesn’t have the choice that some seasoned users would like.
Luckily, there are plenty of third-party alternatives that offer more features
and can help take your photography to the next level, many of which are
completely free. One of the best apps that users can download from the
App Store is Camera+ (£2.29/$2.99). Although it has a rather stripped back
interface, each on-screen toggle hides a wealth of impressive features
beneath. It’s possible to experiment with different shooting modes, as well
as adding different elements that enhance various parts of the image. So
read on and get all the knowledge you need to become an expert on the
fantastic Camera+ app.

Shoot like a professional
with Camera+
Turn your iPhone into a fully featured SLR lens with
advanced shooting modes

Difficulty
Intermediate

Time needed
15 minutes

Improve photography with Camera+Step-by-step

1 Start snapping
The default viewfinder of Camera+ is set out in a
handy grid format. To the right is the zoom bar,
at the top you’ll find variants of flash and at the
bottom are additional controls.

2 Shooting mode
Press on the + icon next to the shoot button 
to see the additional shooting modes that are 
available. You can select a new crop, enable 
macro or select one of the different modes.

3 Stabilised images
Now select the Stabilizer option. Using this 
mode will help keep potential blur in your 
images to its minimum. The more zoom you 
apply, the harder it’ll be to stabilise them.

Camera+
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Go pro
Supercharge your iPhone camera

 Switch cameras
Use the icon at the top-right of the 
shooting screen to switch between 
your front-facing and rear-facing 
camera. You’ll have access to the same 
options with both cameras.

 Burst mode
Using Burst is a great way of taking 
multiple pictures quickly. It’s then 
possible to delete the worst of the 
images and save the rest to your 
Camera Roll.

 Crop selection
To change the ratio of the images you 
want to take, use the crop options to 
select different widths and heights. 
This will automatically update the 
viewfinder grind.

 Set a timer
If you need a timed photo, use the Timer button at the 
bottom of the menu. You can then set how long you 
want the timer to be on the following screen.

Knowledge base
Edit in Camera+
Although it’s a solid 
alternative to the default 
Camera app, Camera+ 
also includes a fairly 
elaborate editing suite for 
users to explore. As well 
as performing the normal 
edits you’d expect to have 
access to, the included The 
Lab feature is a great help, 
getting rid of blur from 
an image and sorting out 
any colour and saturation 
problems it has.

4 Manual controls 
Go back to the viewfinder and press on the 
screen to open the manual controls. Users will 
need to press on the small + icon to open a 
selection of manual toggles.

5 Alter exposure
Select the Exposure option and slowly drag 
your finger around the circle to adjust exposure 
levels. Be careful with your finger movement, as 
the slider is very sensitive.

6 Explore options
Press on the menu icon on the bottom-right 
of the app to see some settings. Here you can 
change the default grid that’s used, as well as 
enable geotagging for your images.
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1 System Preferences
Navigate to the Apple logo in
the menu bar or to the System
Preferences icon in your Dock to
open your System Preferences.

2 Not what you’d expect
Instead of navigating to
Notification Center as you might
assume, click on Extensions and
look under the Today section.

3 No more Mini Player
Under the Today section, check
the box next to iTunes to activate.
Play a song and open Notification
Center to see the controls.

Genius Bar
Our Apple devices and the software on them are some of the finest computing 
products on the planet, but even they have their moments. That’s where we come 
in; to give you expert advice and get you back up and running in no time

I want to be able to control iTunes more easily from my desktop
but I don’t like the Mini Player. What’s my alternative? Philip Lyttle

Facebook: 
search ‘iCreate’

Twitter: 
@iCreateMagazine

Email: 
icreate@imagine-publishing.co.uk

Glossary
The place to come for key 
technical terms made easy 
to understand 

Paragraph Styles
Used to style text in Pages 
with one click. You can use 
presets or create your own. 

iOpener
A microwaveable heat 
pack designed to remove 
screens from iPads and 
other devices.

Themes
A set of pre-existing 
options in Pages, iMovie, 
etc. Themes can help you 
make a document look 
good without much work.

Frames per second
A measure of how motion 
video is displayed. The 
higher the FPS the better 
the quality of the video.

Spudger
A tool with a wide flat, 
wedge-shaped end, used 
to separate pressure and 
fit plastic components 
without causing damage.

HDD and SSD
A HDD consists of a metal 
platter with a magnetic 
coating that stores data. In 
an SSD your data is stored 
in interconnected flash 
memory chips. 

The latest Yosemite update lets you 
control iTunes from Notification Center 
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1 Revealing tip
To reveal the hidden footage from
your clips in the timeline, double-
click the grey rectangle between
the two segments.

2 Edit with precision
Now you’ve opened the Precision
Editor and can see the full clips,
drag the Edit point (the grey
circle) along to make exact cuts.

3 Cut away
You’ll see an edit point between
every two clips on your timeline.
Click on these to move the Precision
Editor to this point and move it.

I took some pictures of my friend’s wedding 
and want to edit them all the same way in 

iPhoto. How can I do this? Natalie Boyd
If you’ve taken lots of photos with the same lighting 
or in the same location, you can use iPhoto to copy 
and paste adjustments. When in Edit mode, select the 
photo to take adjustments from, go to the Edit menu 
and select Copy Adjustments (Option+Cmd+C). Pick 
the photo you want to apply the edits to and select 
Paste Adjustments (Option+Cmd+V). Using this you 
can apply the same set of adjustments like saturation, 
contrast and effects to all your wedding photos. 

@futuresgreen
HNY! Do you know

of any good mail merge
solutions/apps for Mac?
Looked on the app store,
mixed reviews

You might want to
take a look at

SerialMailer. We’ve heard
some great things about it.
Check it out at falkon-ware.
com/SerialMailer and let us
now what you think!

@CallSign_
Hey guys how

safe really are 3rd party
keyboard apps from
seeing everything you
do etc?? And privacy??
Like for example that
popular Swype one wants
permissions for
everything etc??

Always check the 
permissions the app 

requests and use common 
sense on that front. Don’t 
like the look of it? Don’t 
download! We would say 
that Apple vets apps on its 
App Store stringently. 
Popular apps shouldn’t pose 
threats or they wouldn’t 
be popular!

@childofthe1980s 
Why does my 

iPad only connect to 
broadband once I switch 
it on and off again? It 
happens everyday!

Okay, well you 
can try resetting 

Network Settings (in 
Settings>General>Reset), 
or just unplugging your 
router then plugging it back 
in again. Let us know if that 
doesn’t work!

How can I get a more precise cut in iMovie? I can’t even see all of the 
original footage! Harry Shannon

How do I add a Table of Contents to a Pages document without 
typing it all out by hand? Louise Hamblin

 Table service
Place your cursor where you 
want your contents section. Go 
to Insert>Table of Contents. This 
will create a dynamic contents 
table on this page and show the 
relevant toolbar on the right. 

 Checking boxes
Check the boxes beside the 
Paragraph Styles that you want 
to appear in the contents table. 
Pages will dynamically create 
a hierarchy and even add new 
pages to the contents as you go. 

Copy and pasting adjustments lets you 
effectively batch edit photos in iPhoto

#TechTuesday
Here are the highlights from 
#TechSupportTuesday. Get 
involved @iCreateMagazine

 Find your style
Make sure you’re using 
defined Paragraph Styles, 
such as Title, Subtitle 
and Headings. These are 
often predefined in Pages’ 
themes and will let you 
create a lovely dynamic 
table of contents.

 More options
You can even create 
separate contents tables 
for different parts of 
your documents. This is 
especially useful if you’ve 
got a long, complicated 
guide with a lot of content 
to include.
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“There’s now a 
super-fast way to 
mark your emails 
as read”

The one-stop column 
for Genius advice

How can I switch 
between different 
options in a dialog 
window, like Save, Don’t 
Save, Cancel, using the 
Tab key?
You can enable keyboard 
access by hitting Ctrl+F7 
(+ fn). You should now see 
an additional blue glow 
around the highlighted 
option and you can scroll 
through with Tab. Select an 
option with Space. 

How do I remove the 
default icons from the 
Safari Bookmarks/
Favorites menu that pop 
up when I click the URL 
bar in OS X Yosemite? 
This is pretty 
straightforward. Open Safari 
and click the URL bar. To 
remove a bookmark, simply 
click and drag it out of the 
Safari window. You can 
also reorder bookmarks by 
clicking and dragging.

How can I stop my phone 
calls coming through on 
FaceTime on my Mac? 
I have my phone right 
here; I don’t need to be 
called twice!
This feature could really 
do with knowing when 
your iPhone and Mac are 
close together but until 
then, here’s how to disable 
phone calls on your Mac. 
Open up FaceTime, Choose 
FaceTime Preferences and 
simply uncheck the iPhone 
Cellular Calls option. Then 
sit back and enjoy the 
peace and quiet. 

Apple
Expert

Slo-mo videos are taking up too much room on my iPhone 6. 
Can I make them smaller? Amy Lovell

Good news, Amy – you can ensure that your slo-mo videos take up less 
room on your iPhone by simply changing the frames per second (FPS) 
that they’re shot at. To do this, open the Camera app and swipe to Slo-Mo. 
You’ll see the FPS setting in the top-right corner. Just tap on this and it 
will dutifully change from 240 to 120. Although this is great for fixing your 
storage problems, don’t forget that it will also result in a lower quality in 
your slow-motion videos. 

I want a quick way to 
mark my emails as unread 

in Mail for iOS. Is there one? 
Hannah Burton
Yes there is Hannah. Most people 
will be used to using the Flag 
menu to mark emails as unread 
but this takes a long time and 
there’s always a risk of a finger slip 
accidentally flagging or marking 
emails as read again. There’s now a 
super-fast way to mark your emails 
as unread. Just tap and swipe right 
on any read email and when the 
blue ‘Mark as unread’ message 
appears, just let go. 

Order, order
To reorder the 
widgets just tap 
and drag the little 
lines on the right of 
each widget. This 
is a great way to 
personalise your 
Notification Center.

Adding apps
Once you’re in the Edit 
menu, tap the green 
plus icon on the left to 
add an app’s widget to 
Notification Center.

Removing apps 
To remove an app, tap on 
the red circle to the left of 
its name and then hit the 
Remove button when it 
appears on the screen.

Fully 
customisable
There are now 
hundreds of apps 
with Notification 
Center widgets. Any 
compatible apps you 
own will be in this list. 

Genius Bar

All I’ve got in my Notification Center is the default calendar. How 
can I add more widgets? Peter Young

Changing the FPS of slo-mo videos is easy
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“You can record 
multiple tracks 
with different 
instruments to build 
up your ringtone”

1 Compose your own
Fire up GarageBand on your iPhone and tap
+ to create a new song. Play around on the
instruments until you’re happy with the sound.

2 Recording in progress
Hit the little red dot to start recording and play
your song. You can record multiple tracks with
different instruments to build up your ringtone.

3 Export as ringtone
Head back to the Your Songs screen. Hit Select, 
choose your new song, tap the Share button 
and look for Ringtone in the options.

I filmed a bunch of stuff on my iPad
but when I import it into iMovie, it’s

all gone sideways. Is there a clever way for
me to fix this? Tim Millar
Tim, this probably happened because you
hit Record and then rotated your iPad, but it’s
an easy fix. Drop the offending clip into your
timeline and place the playhead over the top
of it. You should see your clip in the preview.
Next place two fingers onto the clip preview
and rotate it in any direction. The clip should
rotate 90 degrees in the direction you moved
your fingers. You can do this for as many clips
as you need and can even have some fun with
upside-down videos.

I want to do my Keynote
presentations from my iPad. Can I

get a remote control for this like I use with
my computer? Sarah Williams
Yes, Sarah, you can get a remote control.
In fact you can use another iOS device to
control your iPad. Open Keynote on the
device that you’ll be presenting with and go
to Tools>Presentation Tools>Allow Remote
Control, and then tap the switch to Enable
Remotes. On your remote device, open
Keynote and select the little Remote icon in
the toolbar. Follow the instructions and select
the iOS device that will be the remote control
in order to link them over Bluetooth.

I’m tired of my iPhone’s 
default ringtones. Is there 

an easy way to make my own? 
Richard Davies

I want to share Pages documents between my iPad and 
Mac but iTunes is a hassle. Is there an easier way? Ross Gardner

If your clips are the wrong way 
round, there’s a quick fix

You can use another iOS device to 
control Keynote on your iPad 

Sharing is caring
To avoid using iTunes to share your Pages 
documents, tap the Share icon in the top-
right corner of your screen to see your 
other options.

Plenty of choice
Pages will let you send your documents 
as a PDF, ePub or even a Word document. 
With these options you’ll always be able to 
send a compatible copy of your doc.

iCloud
Don’t forget, if you’re an iCloud user you 
can always set up your devices so your 
Pages documents are accessible from all 
of them. 

Send a copy
If you tap on Send a Copy, Pages will offer 
you some options to export your file. 
Choose one and then tap Email in the next 
screen to send yourself a copy.
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5 Disconnect it
Use the pull tab to lift the hard drive out of the upper 
case and pull the hard drive cable away from the 
body of the hard drive.

6 Out with the old
Remove the hard drive and then the four 6.0mm T6 
Torx retaining posts from the sides of the drive. Swap 
these to your new drive and reverse the steps.

3 Screw
Remove the two Phillips screws that are securing the 
hard drive bracket to the upper case. Note that these 
screws will stay attached to the hard drive bracket.

4 Up the bracket
The next step is to remove the hard drive bracket. Be 
aware that the bracket may be firmly seated against 
the upper case.

1 Switch off
With your Mac powered down and the back casing 
removed, use a spudger to pry the battery connector 
upwards out of its socket on the logic board.

2 Bend it back
Bend the battery cable a little bit away from its socket 
on the logic board so it doesn’t reconnect itself 
accidentally while you’re working.

The one-stop column
for Genius advice

Is it safe to use a 60w or
85w Power Adapter with
my MacBook Air, which
originally shipped with
a 45w power adapter?
What’s the difference?
Yes! This is an age-old 
question but was actually 
answered by Apple a while 
ago. These higher rated 
adapters should have no ill 
effects on your MBA. A 45w 
adapter won’t charge your 
MacBook Pro, though. 

I accidentally got an SD 
card stuck in my iMac’s 
CD drive. What can I do 
to get it out?
We wouldn’t recommend 
taking any drastic measures 
here. The best thing to do 
is to book a Genius Bar 
appointment and take your 
Mac into an Apple Store 
and let the experts sort it 
out. They’ll probably use 
tape to grab the SD card 
out of the drive.

What’s the best way to 
clean my Apple wireless 
keyboard? It’s getting 
a little grubby and I’d 
rather not stump up the 
cash for a new one.
You can buy specialist, 
cleaning liquids from the 
Apple Store (in-store and 
online) to clean up your 
Mac’s keyboard. Dab some 
on a soft cloth and give 
your whole machine a 
clean while you’re at it. Use 
a cotton bud to get into 
those nooks and crannies 
round the keys, but always 
be careful.

Apple
Expert

The hard drive in my late 2011 13” MacBook
Pro just isn’t big enough. How hard is it to

replace one myself? Katherine Craig
We feel your pain, Katherine. With all the media we’re consuming these 
days, hard drives fill up so fast! This upgrade can be done at home but 
requires a bit of work and some skill. A replacement hard drive will set you 
back anywhere between £105-£130/$120-$150 depending on the size and 
whether it’s an SSD or HDD. An SSD will be quicker but will cost more if 
you want to go big. The steps below will show you how to replace the 
hard drive but we’re going to assume you know how to remove your 
MacBook’s back casing and you have a Phillips #00 screwdriver, a spudger 
and a T6 Torx screwdriver to hand. Remember to back up first!

Genius Bar
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Well Steven, unfortunately the iPad mini 3 wasn’t designed with home repair in mind. A lot of its
components are glued in and it can be a total nightmare to take apart and reassemble. Depending on
how bad the damage is and how long you’ve had your iPad, it might be better to head to an Apple 
Store and find out if they can replace it for you. There might be a cost for this but it could save you a 
lot of time and effort. If you’re still determined to go DIY, then there are some fixes you can try at home 
but be prepared for a difficult teardown. We’ve pointed out some of the more repairable components 
below and outlined some prices for you. Remember; if in doubt, consult an expert. Good luck!

Tools needed
Missing any of these? 
You can order any parts 
or tools you need from 
www.ifixit.com/store.

iFixit Opening Picks 
set of six
iOpener
Phillips #00 
screwdriver
Phillips #000 
screwdriver
Spudger
Tweezers

If you would like more help with upgrading your Mac, visit the 
gadget surgeons at iFixit.com, who kindly contributed these photos.

Contact 
us today

Facebook: 
search ‘iCreate’

Twitter: 
@iCreateMagazine

Email: 
icreate@imagine-
publishing.co.uk

I dropped my iPad mini 3 and it’s trashed. What kind of costs am I 
looking at to repair it myself? Steven McCallister

 Display assembly
The LCD and glass are not fused together 
and can be replaced independently of 
one another, so if you’ve gotten away 
with just cracking the glass then you 
might be in luck. A replacement will cost 
you around £30/$39.

 Internal components
Unfortunately huge amounts of adhesive 
hold many components in place in the 
iPad mini 3. This includes the front glass, 
battery, front camera, back camera and 
ribbon cables. This is going to make repair 
really difficult so best to avoid these!

 Lightning connector
The Lightning connector is actually 
soldered directly to the logic board, so 
don’t bend its pins. This could do some 
serious damage to your iPad!

 Home button/Touch ID
If you need to remove the home button this is going 
to be a difficult job. If you want to retain Touch ID 
functionality after replacing your screen, then you’ll have 
to transfer the home button to the new front panel.

 Battery replacement
If the fall has damaged your iPad’s battery then 
you’re in luck. The battery is not soldered to the 
logic board or any other components so should be 
a pretty straightforward repair. You can buy a new 
battery for around £15/$23.
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Adonit Jot Pro 

£19.99/$29.99 
www.adonit.net/jot/pro

The Adonit Jot Pro is another device with an 
eye-catching selling point. The ball point tip is 
headed by Adonit’s very own Precision Disc, a 
clear plastic disc that helps to create an exact 
contact point on screen. This is no gimmick 
either. Because it’s a thin tip, the Jot Pro is 
easily the most accurate in the test, flexibility 
is outstanding too, while the clear disc makes 
it easy to see what you’re doing. We found it 
excellent at removing blemishes from a vintage 
photo in Pixelmator, while the disc showed no 
signs of scratching our iPad screen.

Elago Stylus Ball 

£TBA/$9.99 www.elagostore.com
Given how cheap this stylus is, the 

quality really surprised us. It feels solid and 
weighty to hold and the silver design of the 
barrel is a classy, very Apple-like touch. The 
textured matte finish aids grip perfectly, too. You
get a replaceable tip in the box (a rarity), which 
means you get a degree of future-proofing, 
especially as Elago boasts of impressive 
durability. The replacement tip is identical, where
a smaller tip would have been more useful for 
tricky edits. A pocket clip would also have been 
a nice addition. Sensitivity is excellent however, 
and all-round performance, can’t be faulted.

DAGi Transparent Accurate 
Capacitive Stylus €15.00/$20.00 
www.dagi-stylus.com
A very similar stylus to the Adonit Jot Pro, but 
with a few notable differences. For a start, it feels 
too small and light – more like a chiselled-down 
builder’s pencil than a top-class capacitive stylus. 
As a result there’s no space for a grip area, which 
was disappointing, but the overall black and 
silver design is perfectly acceptable. The DAGi 
stylus’ clear, plastic disc is connected by a spring 
rather than a ball point and this gave us jerky 
response sometimes, but you can customise the 
angle of your disc to suit your holding habits. 
Accuracy was very good.

31 2

Group test
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Nomad Compose
Dual-Tip Long 
£29.99/$35.00 www.nomadbrush.com
Nomad’s Compose stylus sticks out among the 
others in this group test, offering a replica of an 
artist’s paintbrush as the tip of the stylus. The 
Compose is undoubtedly a classy-looking stylus. 
Its thin barrel is a carbon copy of a paintbrush, 
but as a result, isn’t the most comfortable stylus 
to use. If you have a blank canvas to work on, 
you’ll love using the Compose, but it is not 
conducive for intricate painting. We were also 
concerned that as you applied pressure, the 
brush hairs spread and impaired visibility. A nice 
idea, but one that needs some development.

The Core ARC Stylus 

£16.99/$21.99 www.mobilefun.co.uk
Another silver barrel and black rubber tip 
combination, differentiated by its knife-like 
design. This will split opinion, but we found it 
comfortable to use. The rubber tip was great 
for navigating around and responsive enough 
to handle fast-paced gaming. The fact that 
one of the main selling points is that it stops 
fingerprints appearing on the screen says quite 
a bit about the ambition of the ARC Stylus – it 
does its job well but it is rather nondescript and 
struggles to stand out in this group test. It’s not 
the cheapest on show here either, so you may 
want to look elsewhere.

4 5 6

HexStyli 6-in-1 Stylus Pen 

£9.99/$12.99 www.mobilefun.co.uk
If the ARC Stylus didn’t offer enough, the same 
cannot be said of the HexStyli 6-in-1 stylus pen, 
which throws the proverbial kitchen sink at its 
feature set. In some regards the actual stylus (it’s 
a rubber tip, and one with not enough depth 
to it) ends up playing second fiddle to the 
built-in spirit level, ruler, actual pen and… wait 
for it… two Phillips screwdrivers. Once you get 
past the thought that you’ve pulled something 
out of a Christmas cracker, though, you’ll find a 
tough, multi-purpose tool that you wouldn’t be 
ashamed to be seen with when your using your 
iDevice out and about. 



Front or rear
The lenses work on both the front
and rear-facing cameras. Just flip

the view on your iPhone as you
would normally.

The olloclip 4-in-1 lens is so
compact that it’s hard to
believe it consists of four

lenses. The great thing about
all four lenses being contained
in one small accessory is that
it’s easy to carry around in your
pocket. If you’re looking for added
protection, though, it comes with
a lens caps and a small drawstring
bag. You also have a choice of
three coloured pendants that slot
over the accessory, enabling you to
wear it on a keyring or make use of
the supplied lanyard.

Attaching the device to your
iPhone couldn’t be simpler. As
long as your phone’s case has
been removed, it slides right on
and secures in place in a matter
of seconds. Each lens is labelled,
so you can see exactly what
effect is going to be captured on
the iPhone’s front or rear-facing
camera. The macro lenses are built
into the mount, while the fisheye
and wide-angle lenses screw on
top of them (they’re screwed on by
default, so you just unscrew them
if you want to shoot macro). The

Works with
iPhone 6/6 Plus

Learn more
www.olloclip.com

Available from
https://shop.olloclip.com

overall build is solid and robust, but
be careful when unscrewing the
removable lenses, as they can easily
fall to the ground.

As expected, the wide-angle
lens enables you to capture
more of a scene, however, image
quality is noticeably compromised,
particularly when you examine
around the edges. If you’re not
too bothered about this, it’s
an adequate lens for taking a
panorama or capturing the entire
height of a tall building or tree,
but if you’re a photographer who
cares about image quality, you’ll
probably give this lens a miss.

The fisheye lens produces just
the right amount of distortion for
creating a hemispherical image,
and is great if you want to get a
little creative with your shots. We
did find that the lens struggled
in low light, but we had fun with it
all the same.

The macro lenses are where the
device truly shines. The 10x macro
lens produces some incredible
results, allowing you to get really
close to an object that previously

Olloclip 4-in-1 photo lens £69.99/$79.99
Create instant photo effects without an app with a four-in-one, pocket-sized lens

you weren’t able to without it
being horribly out of focus. The
15x macro lens is even more
impressive, as the smallest of details
are displayed in sharp focus when
holding the iPhone just millimetres
from the subject. We’d recommend
the accessory based on these two
brilliant lenses alone.

Although the iPhone becomes
a bit bulky and awkward to handle
once the lens is attached, it’s
a small price to pay when you
realise you’ve added four lenses
to it. And although image quality
isn’t necessarily first-class, you can
forgive the lens for this when you
remember how convenient it is to
carry around and how quick and
easy it is to fit.

If you like this…
You might also like…
Telephoto + CPL lens
£89.99/$99.99
The telephoto enables you
to get twice as close to your
subject, while the circular
polarising lens (CPL) reduces
glare and improves colours.

Buy now?
Pros Creates instant photo effects 
without using an image-editing app

Cons Image quality compromised 
and iPhone is awkward to handle

Pendant
It comes with three different 
coloured pendants, into which the 
olloclip can be slotted and then 
attached to a keyring.

Reveal macro lenses
Turn the fisheye or wide-angle
lenses until they completely
unscrew in order to access the 10x
or 15x macro lenses.

Slide it on
The olloclip easily slides onto the iPhone 
and automatically secures into place. 
Adjust it accordingly so the lens lines up 
with the camera lens. 
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You Take a Lot of Pictures.
Ready to Do More with Them?

Over 25 million creative people on the Mac use Macphun photo apps to
easily create inspiring and dramatic images. Now it's your turn.

Get inspired by the world’s leading Mac-only photo 
apps and turn ordinary photos into powerful, creative 
masterpieces! 

“One-click” easy with no learning curve, the 

problem areas and then make amazing images using 
creative blurring, detail enhancement or even black & 
white toning.

 

Search for our apps on the Mac App Store and get 
www.macphun.com 

to learn more, watch videos and download free trials.

Snapheal Pro, Tonality Pro, Intensify Pro and
Focus Pro are also available through these premium 
resellers in the UK.

Intensify Snapheal Focus 2Tonality FX Photo Studio ColorStrokes Lost Photos

S O F T W A R E

© 2014 Macphun Software.
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Streamline battery usage
Although the Universal Keyboard
does ship with a charging cable,
you won’t need to use it much
if Microsoft’s six-month battery
claims are to be believed.

Clip and connect
The stand and keyboard can

be separated to adjust viewing
angles to your specifications.

Solid design
The build of the Mobile
Keyboard isn’t as
premium as some
may expect, but the
reinforced plastic gets
the job done.

Responsive
Each and every key feels responsive to the
touch, and most impressively, there’s no
delay between keyboard and device.

iOS-compatible Bluetooth
keyboards are in abundance
for users to test out, but one

that’s manufactured by Microsoft
is going to garner a little more
interest. Being just nine inches
long, the Microsoft Universal
Mobile Keyboard works across iOS,
Windows and Android devices,
but is noticeably smaller than
many of its competitors. It comes
in a clamshell-type case, which
although is made of plastic, feels
durable and robust when handling
it. Opening the case reveals a full
Qwerty keyboard, with a selection
of additional keys to use.

Pairing through Bluetooth is
easy enough to complete, and
once done, it’s a simple case of
loading up a message and typing.
For those who prefer a little
more space on the keyboard, the
configuration here will take some
getting used to. Keys are bunched
up and many of the function keys
are on the small side. However,

Compatibility
iPhone

iPad

Learn more…
www.microsoft.com

Available from…
www.microsoft.com

each and every push of a key is 
responsive; something often lost in 
many other wireless keyboards.

As well as the normal keyboard 
setup, there are additional controls 
across the top. These enable users 
to control audio, lock their device 
and play/pause video. All of them 
work well and save you ever 
needing to actually touch your 
device. Also good is the inclusion of 
a little button to alter the viewing 
angle of your phone or tablet 
when placed in the stand. There’s 
not a whole lot of change between 
the two viewing angles that are 
usable, but if neither take your
fancy, you can simply de-clip the
keyboard from the stand and alter
it to your own liking.

Arguably the most impressive
aspect of Microsoft’s Universal
Mobile Keyboard is how it
streamlines battery usage. It claims
you can get six months of usage
before needing to put it on charge,
and during our time with it, we

Microsoft Universal Mobile Keyboard £79.99/$79.95
Has Microsoft managed to make the perfect Bluetooth keyboard?

found the accompanying charging 
cable just stayed in the box. Then 
to turn the keyboard off, it’s a 
matter of clipping the clamshell 
case back together and closing it.

As a package, the Microsoft 
Universal Mobile Keyboard is an 
exciting prospect. Everything from 
the case to the stand feels well 
made, and while the keyboard will 
undoubtedly be a little small for 
some people to use regularly, it’s so 
responsive that we really can’t fault 
it at all. If you’ve got a spare £80 
to spare, the Microsoft Universal 
Mobile Keyboard is certainly a 
fantastic investment.
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If you like this…
You might also like…
ZAGGkeys Bluetooth 
Keyboard Cover
£99.99/$149.99
ZAGGkeys’ super-slim keyboard 
cover includes backlit keys and 
a powerful internal battery to 
negate the need for a charger.

Buy now?
Pros Lightweight, easy to use and 
responsive keyboard setup

Cons Plastic build won’t be to 
everyone’s tastes
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Power
The only button on the 
device, press it to power 
up the device and then 
short-press to start up the 
portable Wi-Fi network.

Display LEDs
One for power, one for Wi-Fi 
signal; when they’re both 
solid you’re good to go and 
if you ever drop a connection 
then just glance at these.

SS USB
SuperSpeed USB 3.0 means that you can take 
advantage of impressively fast upload and 
download speeds on a wireless connection.

Casing
Available in more Mac-suited 
white and grey colours as well, 
the casing is smart without 
being flashy and well suited to a 
tidy desktop environment.

The strength of the Seagate
Wireless Plus storage system
is its simplicity, in terms

of both form and function. It’s a
smart little thing, in a well-crafted
chassis with a textured black plastic
casing and a dark grey panel across
the top, and considering it will fit
into a large jacket pocket, it’s very
powerful for its size.

This mobile storage device gives
you two terabytes of storage and
can easily be accessed wirelessly
through not only your Mac, but
also your iPhone and iPad via the
Seagate apps, not to mention any
PCs you find yourself working
with on occasion. There’s just a
single button and single port, the
former powering up the device
and the Wi-Fi network you use
to connect, and the latter being
an SS (SuperSpeed) USB port for
recharging and wired connections.

On your first connection with
a Mac you’ll need to go wired,
running the installation DMG and
then registering your product.
Unfortunately you can’t skip that
registration, and the amount of
information requested seems
largely unnecessary, but that’s a

Compatibility
Mac

iPhone

iPad

Smart TV

Learn more…
www.seagate.com

Available from…
www.amazon.co.uk

relatively small gripe. Watch out for 
Time Machine as well, which tries 
to jump in and take over the device 
as a backup destination – do that 
and you’ll end up ruining the 
filesystem, as noted in the Quick 
Start guide supplied in the box.

Once you’re up and running, you 
can access your backup box by 
simply connecting to your Wireless 
Plus’ Wi-Fi network and going to 
seagatewireless.com. (Be aware 
that in our tests, we had to unplug 
our Mac’s Ethernet cable in order to 
get the web interface to load.) It’s 
a really nicely designed interface, 
with photo thumbnails for every file 
(even the placeholders look good) 
and design elements taken from 
the previous-gen OS X palette, with 
menus given the iOS treatment 
to create a seamless experience
between your desktop and mobile
devices. By default you’re greeted
with the standard media categories
– Videos, Photos, Music and
Documents – but you can switch
to a folder view as well and see
your custom hierarchy, again with
the same visual thumbnail layout.

A really nice touch is that much
of your content can be streamed

Seagate Wireless Plus 2TB £159.99/$199.99
Seagate’s storage system ensures your media is accessible on all your devices

in-browser, with documents 
loading in tabs, photos opening 
out into a full-screen gallery with 
keyboard control, songs streaming 
in lightweight players and even 
MP4 videos playing too (though 
we couldn’t get AVI and MOV files 
to stream). You can even get AirPlay 
involved in the action. 

The Settings menu is a little 
minimal but has some important 
options, including a power-saving 
Eco mode and the ability to set 
a password to protect against 
unwanted connections. Three 
more features really sold it to us: 
the ability to sync your Dropbox 
and Google Drive files, an icon to 
show how many users are currently 
connected (great for home use) 
and a select tool for editing and 
deleting files in batches.
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If you like this…
You might also like…
Synology DS115j
£78/$118
You’ll need your own hard 
drive and it isn’t as portable as 
the Seagate, but the DS115j is 
blazing fast and has a billion 
secure connection methods.

Buy now?
Pros Straightforward, stylish and 
multi-platform. Indispensable

Cons Price could be more 
competitive given the competition
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When it comes to iOS
and DJ apps, it would
be safe to say developer

Algoriddim leads the way. With
over 50 million downloads of the
‘djay’ series across iPhone and iPad,
fans have been eager to see a
new version hit OS X since the last
update in 2011.

Well, here it is, in what we’re
told is a whole new suite built
from ‘scratch’ – pun intended.
Moreover, this version arrives with
much-touted features for music
discovery. For starters, users will
immediately be impressed by
the solid and consistent iTunes
compatibility. Chances are that
your iMac or MacBook is your main
music hub and djay Pro recognises
this by pulling in your collection
seamlessly. Rather than importing,
it simply accesses the existing song
data, adding tags for BPM and Key
after playback. Switch to Spotify
and performance is identical,

facilitating instant track previews
and cuing on even the most basic
of connections.

Although named as ‘Pro’, in truth
this an app ideal for all levels thanks
to solid controls for controlling
RPM and song key. A Sync button
matches timing instantly while
transposing offers true harmony
and fewer surprises when you flip
that fader. Although these tools
are accessible, they don’t hold your
hand the whole way. Getting the
best results requires you to switch
into djay Pro’s waveform view
where the colour-coded sound
peaks can then be nudged into
alignment with greater precision.
This is aided by a comprehensive
array of keyboard shortcuts that
speed up operation and ensures
your playlist keeps spinning.

More advanced users will
doubtlessly prefer the use of a
favourite DJ controller and djay
Pro boasts extensive support

here. In addition, a robust MIDI
Learn feature provides a mapping
system for wider compatibility. This
will inevitably unlock the deeper
capabilities of the software, making
the necessary ‘knob twiddling’
feel more natural during live
performance. When you then
throw in an expandable roster of
drum sounds and effects, as well as
gloriously simple tools for isolating
loops – there’s just so much to like
here. Whether you’re a pro or not,
there aren’t many better ways to
enliven your local and cloud-based
music collection than with djay Pro.

djay Pro £39.99/$49.99

Compatibility
OS X 10.9 or later
64-bit processor
29.6MB hard drive space

Learn more…
www.algoriddim.com/djay-mac

Available from…
Mac App Store

Buy now?
Pros Seamless iTunes and Spotify 
support, tools for harmonic mixing

Cons Sadly the music, dance floor, 
dancers and drinks aren’t included

The djay series returns to OS X promising powerful mixing tools and Spotify support

Spinning around
Twin turntables 

enable you to 
manipulate 

playback directly, 
scratch the virtual 

vinyl, stop/start the 
decks and crossfade 

the output. 

Seeing the 
sound
Waveform displays 
provide a finer 
level of feedback, 
enabling you 
to see how the 
audio patterns 
lock together for 
greater accuracy.

Keeping tracks
The Library panel 
toggles between 
local iTunes and 
cloud-based 
Spotify collections, 
facilitating instant 
access to all your 
favourite floor fillers.
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Following the success
of Elements 3D, Video
Copilot has released the

second instalment of its hugely
popular After Effects plug-in. E3D
allows the user to animate and
light imported 3D objects within
AE, and the extensive upgrades V2
brings to the plug-in means it is an
essential tool for any designer or 3D
enthusiast eager to streamline their
working process.

Though Elements 3D does
not allow for fully-fledged 3D
modelling and animation within
AE, it does come packaged with
basic 3D models and primitives,
and is compatible with many
standard 3D file formats. As with
V1, this new version can import
3D objects in C4D or OBJ formats,
animation OBJ sequences and
3D textures such as PNG, JPG or
EXR. With the V2 upgrade comes
automatic texture importing for
C4D and OBJ with MTL files.

Most notably, it now includes
soft shadows and ambient

occlusion (SSAO): essential tools
for achieving high quality, realistic
shadows on your 3D creations. V2’s
OpenGL Shadows and improved
SSAO come in handy if you need
to get a project done quick, or, if
quality is what you’re aiming for,
V2 can put ray tracing to work for
shadows and ambient occlusion.
Furthermore, the backlight lighting
pack and dynamic reflection maps
are a great addition that will make
your 3D work look very impressive.

To make up for its lack of
character animation features, the
plug-in now includes Deformers,
which let users distort shapes. This
is a great convenience for those
wanting to create basic distortion
animations without Maya or
Cinema4D. Additionally, the 3D
Noise feature offers advanced
fractal settings and multiple noise
distortion modes, including particle
noise sub surface scattering.

Designers looking to improve
their logos and titles will appreciate
the new bevel and extrude

features. Users have the option to
animate individual characters, add
multiple bevels per object, as well
as create a bevel outline, which
extrudes from shape edges.

Along with the improved render
times, much of the V2 upgrade
is speed. The added keyboard
shortcuts and streamlined UI layout
allow for a much faster, more
convenient environment. Boasting
an array of improvements and new
features, Elements 3D V2’s upgrade
adds another level of realism and
flexibility to 3D object and particle
system rendering within AE that
may just turn the heads of those
who glanced over it before.

Element 3D V2 £130/$199

Compatibility
OS X 10.7 and up
Recommended GPU specs: 
GeForce GTX 660 or AMD 7850 at 
least. Minimum of 1GB VRAM

Learn more…
www.videocopilot.net

Available from…
www.videocopilot.net/products/
element2

Buy now?
Pros A vast improvement on V1’s 
already impressive lighting tools

Cons Not enough features to serve as 
a replacement for Maya or Cinema4D

A 3D plug-in that could become invaluable to your After Effects toolkit 
3 Key 
Features

Drag and drop
Materials can be accessed through 
drop-down menus, and quickly 
applied to objects.

Deformers
The new Deformer tool is a highly 
anticipated addition to V2, great 
for animating primitives and logos.

Aux Channel Animation
Sub-Object Auxiliary Channel 
Animation allows for basic 
animation of individual objects.
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For those who like to
code, the right code
editor is an essential fit.

OS X is not short on good code
editors, but different developers
have different needs and
preferences. Sublime Text, Coda
and Brackets are already hogging
the market space, but Peppermint
is a new code editor looking to
take its place alongside, or even
supersede, some of the more
established players.

As soon as Peppermint was
installed and opened up for the
first time, it had an air of familiarity
about it. As Sublime Text fans, we
immediately felt at home with the
user interface. The three element
UI gives the user access to files,
code and a command line. As you
would expect there is the option
to customise – re-arrange the
windows, remove a window and
even implement one of the built-
in themes to change the colour.
It must be said that the themes
effectively only switch between

light and dark, probably the best
two choices for most developers.

The syntax support is extensive,
currently boasting around
70 languages including C++,
CoffeeScript, Dart, JavaScript
Python, Ruby, HTML and CSS. It
even offers support for some of
the real old boys including COBOL,
Pascal and Assembly. The code
window is colour-coded for easy
reading and line numbers are
included. To save some screen
space the lines can be collapsed
if desired. There are plenty of
editing options to make the coding
process easier and more efficient.
What’s on offer? Autocompletion,
search and replace and remove
duplicates to name a few. There is a
terminal window to run code that
defaults to CoffeeScript but can be
changed to JavaScript. Plus, there is
the option to share via GitHub.

To extend the power of
Peppermint there is the option to
add plug-ins. These are easy to add,
but currently there isn’t a great deal

of them out there. As time goes
by more will be added, making
Peppermint an even more tasty
and tempting code editor.

As with any software the price
can have a major bearing on
the decision-making process.
Code editors like Sublime Text
and Coda hover round the $70
mark (approx £45), while Brackets
is free. Peppermint weighs in at
a very enticing $14.99. Should
you get your hands on a copy
of Peppermint? You can try the
free ones, because they’re free,
but if you want a powerful low-
priced alternative to Sublime Text,
Coda and its ilk, Peppermint is a
refreshing choice.

Peppermint £10.25/$14.99

Compatibility
OS X 10.7 or later
64-bit processor

Learn more…
http://osxpeppermint.com

Available from…
http://osxpeppermint.com

Buy now?
Pros A powerful code editor that 
competes with more expensive rivals

Cons There are similar editors that can 
be obtained for free

An enticing OS X code editor with plenty of power, poise and a rare touch of class

3 Key 
Features

Syntax support
To give Peppermint wide appeal, 
the code editor supports all the 
major development languages.

Themes
A selection of bright and dark 
built-in themes enables users to 
perform low-level customisation.

Templates
Pre-installed templates let users 
create new fi les that are already set 
up for the preferred syntax .
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If you’re an avid gamer,
then the App Store has
a ton of amazing games

ready for you to download and
play. However, nothing beats
actually putting together your
own game, and while most won’t
have the necessary knowledge or
experience to do so, The Adventure
Creator looks to bridge this gap
and get people to bring their ideas
to life all on any iOS 7.0, or higher,
enabled iPad.

Through TAC’s superb creation
interface, users will be able to put
together their own graphic and
text adventure game through
some basic coding. The coding
aspects offer a great entry-level
platform for both children and
adults with no previous coding
experience, with helpful tutorials
only being a few seconds away if
you get stuck at any point. Once
the basics have been mastered,
it’s then a case of piecing together

your story with the only limit being
your imagination.

Each piece of the game can
be heavily customised and older
users will be able to recreate
some of the best moments from
previous graphic adventure titles
they’ve played. It’s possible to
add soundtracks to each stage of
your game, as well as implement
custom photos to represent where
the player is. It can take a while for
soundtracks to be added, but it
seems to be purely down to the
size of the track in question rather
than any substantial problem.

The other main section of TAC
is testing your game. Not only is it
great to see your creations come to
life, it’s the perfect opportunity to
test it thoroughly for bugs, which
they’ll be plenty of if it’s your first
game. By then using AirDrop, you
can share your finished games
with friends who can try and solve
them. When sharing, you’ll have

the option to leave your game
locked, or unlocked, with unlocked
enabling others to edit parts of the
game and adapt it to suit how they
want the game to look and play.

Although we’ll praise TAC for
enabling users to bring their ideas
to life, what we love more than
anything else is how it can be
used for educational development.
Coding isn’t the easiest thing to
learn from scratch, but TAC offers
a simple platform for users to get
to grips with the basics and enjoy
making an adventure game at the
same time.

The Adventure Creator £2.99/$3.99

Compatibility
iOS 7.0
iPad

Learn more…
www.theadventurecreator.com

Available from…
iOS App Store

Buy now?
Pros Simple coding system for 
beginners and avid gamers alike

Cons Soundtracks can take a little 
while to load into the game

Create and code your very own graphic adventure game

3 Key 
Features

Implement items
Add detail to each stage of your 
game by adding usable items and 
weapons that the player can fi nd.

Custom soundtracks
By implementing music, you’ll 
be able to add some fantastic 
atmosphere to sections.

Test it out
Play the full game on your iPad as 
soon as you’ve fi nished coding to 
test it out and fi nd any bugs.



Let’s face it, Dirt 3 is the
closest most of us will 
get to hurtling down 

the Norwegian countryside in a 
Ford Mustang GT. Although in real 
life, there’s no doubt this venture 
would be terrifying from one 
minute to the next, in Dirt 3 the 
entire ride feels like an absolute joy.

This experience transcends well 
into the other areas of the game’s 
driving mechanics. Everything 
feels tight and responsive, but 
leaving enough room for there 
to be considerable danger when 
travelling at speed. The driving 
mechanics differ depending on 
the type of terrain you’re racing 
on, and in some cases, the course 
you’re speeding around. This time
around there’s the addition of rain
and snow that make it harder to
stay in control and go far past just
cosmetic value, which is something
other rally games are guilty of.

To take advantage of the
astonishingly large spectrum of

cars, which cover everything from 
buggies to high-spec trailblazers, 
you’ll want to immerse yourself 
in Dirt’s season mode. There are 
four parts to the main season 
mode; with each having different 
events to take part in. The variety 
is good at the beginning, with 
races taking part all over the world 
and requiring you to use different 
vehicles, but soon becomes stale 
with certain races being repeated 
on occasion. In this instalment of 
the series, there’s the addition of 
a new Gymkhana mode. Instead 
of racing, Gymkhana is all about 
completing tricks to accumulate 
points in a set amount of time. It 
takes some considerable skill to 
nail correctly and is arguably a bit
bland compared to the game’s
core racing elements, but a nice
distraction at times.

Without doubt the crowning
feature of the Dirt 3 experience,
however, is the graphical prowess
being shown throughout. If your

Mac can handle it, then expect 
to see mud and snow flailing 
all over the place and every car 
shimmering in the sunlight. It’s 
a truly stunning game and we 
thankfully found no annoying 
texture popping as we played.

Racing games have some fierce 
competition, but Dirt 3 generally 
feels like a well-built and diverse 
product. Although improvements 
could be made to expand the 
variety of modes even more, there’s 
simply nothing that comes close 
to the rugged and rough rally 
experience that this beautiful game 
can offer.

Minimum
requirements

OS X 10.9.5
Intel 2.0GHz processor
4GB RAM, 256VRAM
14GB HD
Keyboard

We used
iMac Mid 2011
2.5GHz Intel Core i5
4GB RAM, 512VRAM
PS3 controller

Learn more…
www.feralinteractive.com

Available from…
www.feralinteractive.com

Dirt 3 Complete Edition £22.99/$29.99
Speed to glory in this action-packed racer that swaps tarmac for dirt

Do whatever it takes to reach the top of the podium

Get the true taste of speed by 
heading into the first-person view

Make (not eat) doughnuts to 
accumulate points in Gymkhana

There’s no time for snow angels when 
rallying in snowy conditions

Buy now?
Pros Tight racing controls partner a 
beautifully designed backdrop

Cons Main season mode can get 
stale, with Gymkhana also bland
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YOUR FREE RESOURCES
Log in to www.filesilo.co.uk/icreate and download the latest
collection of must-have creative resources and tutorial assets

YOUR BONUS
RESOURCES

ON OUR BRAND-NEW FILESILO 
THIS ISSUE YOU WILL FIND AN 
UNMISSABLE COLLECTION OF 
CREATIVE RESOURCES

All-new tutorial files to help you get
more from your iCreate projects
Over 15 minutes of expert video guides 
from the brilliant MacMost team
Two great Typodermic fonts

your iMovie and Final Cut projects
Ten wallpaper designs for OS X and iOS

total  
resources

www.filesilo.co.uk/icreate
108

Tutorial files
This issue’s brilliant assets

Expert video guides

RESOURCES   FILESILO
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Stunning wallpapers



FILESILO –THE HOME OF PRO RESOURCES

The most popular downloads are
shown in the carousel here, so check
out what your fellow iCreate readers
are enjoying!

Green open padlocks show the issues
you have accessed. Red closed
padlocks indicate the ones you need to
buy or unlock.

Find out more about our online stores,
plus useful FAQs like our cookie and
privacy policies and contact details.

If you’re looking for a particular type of
content like brushes or fonts, use the
filters here to refine your search.

Can’t find the resource you’re looking
for in these filters? Click on More
Options to specify exactly what kind of
resource you want.

Top Downloads are listed here, so you
can get an instant look at the most
popular downloaded content.

Check out the Highest Rated list to see
the resources that other readers have
voted for as the best!

Discover our amazing sister magazines
and the wealth of content and
information that they provide.

The first time you use FileSilo you’ll need
to register. After that, you can use the
email address and password you
provided to log in.

This is the new FileSilo site that replaces
your disc. You’ll find it by visiting the
link on the following page.

A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

DISCOVER YOUR FREE ONLINE ASSETS
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How to use
Everything you need to know about

accessing your new digital repository

GET IN TOUCH WITH
iCREATE MAGAZINE

ToaccessFileSilo,pleasevisitwww.filesilo.co.uk/icreate

01 Follow the
instructions

on screen to create an
account with our secure
FileSilo system. Log in
and unlock the issue by
answering a simple

question about
the magazine.
You can access
the content
for free with
your issue.

02 If you’re a print
subscriber,

unlock all the content by
entering your unique
Web ID. Your Web ID is
the eight-digit
alphanumeric code that
is printed above your
address details on the
mailing label of your
subscription copies. It
can also be found on any
renewal letters.

03 You can access
FileSilo on any

computer, tablet or
smartphone device using
any popular browser
(such as Safari, Firefox or
Google Chrome).
However, we recommend
that you use a computer
to download content, as
you may not be able to
download files to your
phone or tablet.

04 If you have any
problems with

accessing content on FileSilo,
or with the registration
process, take a look at the
FAQs online or email
filesilohelp@
imagine-publishing.co.uk.

www.icreatemagazine.com
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Next issue…
iCreate 145, on sale 2 April 2015

GarageBandAperture iPhotoiMovie Final Cut Pro X iTunes Numbers PagesSafari

Facebook:
search for ‘iCreate’

Twitter:
@iCreateMagazine

Email:
icreate@imagine-publishing



Learn in style

Discover more with the Book series’ expert, accessible tutorials for 
photography, 3D art, Photoshop, web design and more

The

Series

BUY YOUR COPY TODAY
Print edition available at www.imagineshop.co.uk

Digital edition available at www.greatdigitalmags.com

facebook.com/ImagineBookazines twitter.com/Books_Imagine
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For Mac, iPad and iPhone users

Time Machine

Newton 
MessagePad 
August 3rd 1993

Original price
£489/$699

Price now
£110-125/$150-$200
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